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Chapter1
Using In-Document Analytics

This topic provides an overview of In-Document Analytics, introducing you to the basics of
viewing reports, charts, and dashboards in an offline environment.

In this chapter:

Overview of In-Document Analytics

Overview of In-Document Analytics

Content that uses In-Document Analytics provides users with an interactive interface that
allows the generation of real-time, dynamic reports, charts, and dashboards. Its versatility
allows you to package a data set with a combination of analytical views, resulting in highly
intuitive and interactive self-service business intelligence. This gives you an edge in
presentation and analysis, making it easy to develop and share concepts, ideas, and
scenarios. An interactive report is a self-contained report, meaning that it contains all the data
and JavaScript® within the HTML output file. Packaging the data and the interactive functions
in the HTML file also makes the output highly compressible for email and transparent to
security systems. If you are working with a larger data set, you can also zip the output files to
reduce the file size when sending them through email.

Note: You may need to zip interactive content output files to reduce the file size, and send
them through your email client.

Your users can explore and interact with your data using various analytical tools such as
sorting, filtering, calculations, roll-ups, and pivoting. They can also experiment with different
scenarios using various options.

All of the interactive content that you create functions independently of a server, and is
portable, making it easy for your users to work with and analyze complex data without requiring
the use of an external application, such as Microsoft Excel. With two types of users (developer
and end user), the roles in development and delivery of materials are clear. The end user
interacts with the content that the developer creates and deploys. They can obtain content
without any additional plug-ins or programs should they choose to access your content
remotely or offline, independent of a server.

Note: Each artifact that you create at run time is given a unique number for easy identification.
This number is incremental but not consecutive, and is assigned automatically.
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In InfoAssist, there are two output formats that you can use to enable In-Document Analytics
functionality: HTML Analytic Document format (formerly known as AHTML) and PDF Analytic
Document format (formerly known as APDF). Using Analytical Document format (ADF), you can
generate dynamic content and distribute it offline, even when you are disconnected from a
browser. When working with the new Designer style, only AHTML format is supported.

Note: These formats are enabled in the Administration Console by your administrator. As a
developer, once you have access to these output formats, you can begin generating content
that you can distribute across your enterprise. The HTML Analytic Document format, as it
appears in InfoAssist, is shown in the following image.

Overview of In-Document Analytics
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There are also two available styles that you can apply from the Procedure Settings dialog box.
If you created interactive content in an earlier release, you can continue to use this style,
which is known as Legacy. Legacy provides options like the Chart/Rollup and Pivot tools. An
example of legacy style in a report is shown in the following image.

Alternatively, you can use the Designer Style, which currently presents some of the same
options, but displays more like a page that you create in WebFOCUS Designer. An example of
Designer style in a chart, is shown in the following image.

1. Using In-Document Analytics
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When you run your content, you can review and continue to develop it using the available
menus. For example, when you run a chart, you can select the chart menu to change the type
of chart you are showing, as shown in the following image.

Overview of In-Document Analytics
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To add a new chart or edit your content, you can use the options available from the vertical
Ellipsis menu, which is shown in the following image.

When you view your report or chart at full screen, a hamburger menu also displays, as shown
in the following image. From this menu, you can exit full screen, save changes, or restore the
dashboard.

Interactive content that you create in WebFOCUS, such as reports and charts, are saved as
procedures. You can view the code that is stored in the procedure from within InfoAssist, or
the Text Editor. When you view the code for interactive content, you will be able to see which
style the procedure uses, with the ARVERSION setting. Interactive content using the Legacy
Style is ARVERSION=1, while the Designer style is ARVERSION=2.

1. Using In-Document Analytics
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By default, all new content that you create in InfoAssist uses the Designer style,
ARVERSION=2. If you edit an existing item that uses the Legacy style, that style will remain
unless you change the ARVERSION to ARVERSION=2. This would reset the content to display in
Designer style.

You can also password protect your interactive content to restrict users from viewing it unless
they enter a password. Data is encrypted using the 256-bit Advanced Encryption Standard
(AES) specification, and the password is used as the key for decrypting and encrypting the
data. Therefore, the password is not stored in the interactive content, and you do not need a
connection to go back to the server for password verification.

The HTML page, enabled with In-Document Analytic capabilities, contains both the JavaScript
and the data for the content so you can interact with the data in a disconnected mode. Internet
Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer
warning, it mentions explicitly the detection of interactive content, which is the JavaScript. The
same warning appears when pop-ups are blocked in the browser.

Because all post-retrieval processing is performed in the memory of the web browser,
interactive content that has In-Document Analytics enabled has a processing limit of
approximately 5,000 records or 100 pages of output. Using the cache option, you can send
only the first page of content output to the browser and retrieve subsequent pages from a
temporary cache on the Web Query Reporting Server. The server also becomes the resource for
performing all calculations, sorting, and filtering when caching is enabled. Since caching uses
on-demand paging functionality, WebFOCUS Viewer is not supported. 

Content with the cache option in the clustered server environment, using Cluster Manager
(CLM), will maintain the connection with the WebFOCUSWeb Query Reporting Server on which
the temporary cache is created. This enables the retrieval of subsequent pages from the
browser, while it is in the same browser session.

Note: When working in CACHE OFF mode, in AHTML (or In-Document Analytics) format, you can
export to CSV (comma-separated values) format at run time. The file is automatically sent to
the Downloads folder, and applies to all browsers.

The caching feature uses a POST instead of a GET in an HTTP request.

Overview of In-Document Analytics
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You can save interactive content from your web browser to another location, such as your
repository or an FTP server. You can also send interactive content by email or by using a
distribution list. This sends the interactive report, chart, or dashboard as an email attachment,
distributing it to one or more people through email, as an HTML attachment. If you are sending
an interactive dashboard that contains one or more reports or charts, you can burst the
distribution by defining parameters in ReportCaster, which sends relevant sections of the
dashboard and saves each section as a separate file. Whichever way you choose to send your
interactive content, you must keep in mind how it will be viewed.

For example, when you send a report as an HTML attachment to email, many client email
programs on a mobile device can block the JavaScript in the attachment. A third-party tool,
such as the WebFOCUS Mobile app for a mobile device, may be used to correctly view the
attachment.

When you create interactive documents that contain more than one report or chart, you can
also share the document by setting up a burst distribution by defining parameters in
ReportCaster. This functionality distributes relevant sections of the dashboard to individual
users you specify, and saves each section to a separate file.

If you try to view an interactive report in a web browser, and JavaScript is blocked or disabled
on your web browser, you will receive a message reminding you that JavaScript must be
enabled on the browser. If you are using a mobile device, the message directs you to use the
WebFOCUS Mobile app. If the app is not installed, you can download it from the App Store® for
iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store
and Google Play store are hyperlinks to the WebFOCUS Mobile app.

The message is displayed on the Desktop or on a supported mobile device when JavaScript is
disabled in a web browser used to open an online or offline report. It is also displayed on the
Preview pane or window of an application used to preview the content of an offline report.

1. Using In-Document Analytics
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The following image shows JavaScript disabled in Google Chrome™.
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Chapter2 Creating Interactive Content With In-
Document Analytics

This content describes how you can enable In-Document Analytics to create interactive
reports, charts, or dashboards that users can view and interact with offline.

In this chapter:

Enabling In-Document Analytics in InfoAssist

Developing Interactive Content

Working With Interactive Content

Creating a Report with In-Document Analytics

Creating an In-Document Analytics Enabled Chart

Creating an In-Document Analytics Enabled Dashboard

Enabling In-Document Analytics in InfoAssist

In InfoAssist, you can create content, including reports, charts, and dashboards that leverage
the interactive capabilities of In-Document Analytics. Enabling this option provides your users
with the ability to interact with and modify the content you created for their own analysis.

Note: If you use the Designer style, you will only be able to select the AHTML output format.
APDF can only be used with the Legacy style.

Procedure: How to Enable In-Document Analytics in InfoAssist

1. Open InfoAssist.

2. Create a report, chart, or dashboard.

3. On the Home tab, in the Format group, click HTML Analytic Document or PDF Analytic
Document.

Note: Your administrator must enable these output options in the Administration Console.

4. Run your content.
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Your report, chart, or dashboard now displays with interactive menu options that can be
used for end-user analysis. You can change the style of your interactive content from the
Procedure Settings dialog box. The two styles available to you are Legacy or Designer
Style. Some of the options available from the interactive menu options may change
between the styles.

Developing Interactive Content

This topic describes how you can develop and enhance interactive content that has enabled In-
Document Analytics capabilities.

Interactive Reports

As a developer, you can create effective, useful reports and share them easily using In-
Document Analytics for offline analysis.

A report is used to show the intersections of data between rows and columns. Once created,
you can style your report, add headers, and footers, and apply other formatting options to
make your data stand out. When you have completed creating your report, you enable In-
Document Analytics. Using this format, your users can interact with data, using analysis
options similar to those found in an Excel workbook. Since no connection to a server is
required to view the data or use the analysis options (for example, filtering, charting, and
sorting), you can save and use the report anywhere.

Note: All reports display with HFREEZE ON, a feature that freezes the headings in your report,
in In-Document Analytics.

Configuring Analytic Document Options for Reports

You can configure analytic document options for interactive reports, including menu options,
based on user role, through the Analytic Document Options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the button.
The button is available when HTML Analytic Document or PDF Analytic Document is selected as
the output type.

The Analytic Document Options dialog box contains the following tabs:

General

Menu Options

Colors

Advanced

Developing Interactive Content
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General Tab

Use the General tab to set common properties specific to interactive, analytic reports.

The General tab contains the following options:

Display. This area contains options to set the window to cascade or tabs, and options to
freeze columns.

Window. Select the window setting. The options are Cascade and Tabs.

Freeze Columns. Select the columns you would like to freeze. You can also select None.

Page Options. This area contains options to set the number of records per page, enable the
display of page information, edit the alignment, and set the location of the page information.

Records Per Page. Select or type the number of records that you would like to display per
page. The default value is 57.

Display Page Information. Select this option to display page navigation information. Clear
this option to disable the display of page navigation information.

Alignment. Click the appropriate button to set the alignment of the page navigation
information. Options are Left, Center, and Right.

Location. Select the location for the page navigation information. The options are Top Row
and Bottom Row.

Chart Options. This area contains options that pertain to charts when the output format is PDF
Analytic Document.

Note: Chart Options do not display when the output format is HTML Analytic Document.

Legend (check box). Select this option to collapse the legend if necessary. Clear this
option if you do not want the legend to collapse.

Legend (menu). Select the location for the legend. The choices are:

Bottom Left

Bottom Center

Bottom Right

Menu Options Tab

Use the Menu Options tab to select a user type and which options to display in the menu. 
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The Menu Options tab contains the following options:

User Type. The options are Power, Analyst, Basic, and Custom.

Power. This is the default user type. It enables all functionality.

Analyst. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original,
Save Changes, and Accordion.

Basic. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.

Custom. If you select a combination of options that does not match one of the existing
user types (Power, Analyst, Basic), the User level name that appears in the User Type
field is Custom. This is not a default user type or a selectable user type. It indicates
that options for this user do not match any of the existing user types.

The options available according to user type include the following:

Show Records. Shows all records or specific numbers of records.

Freeze. Freezes and unfreezes columns.

Hide/Unhide. Hides and shows columns.

Export. Exports data to HTML, CSV, Excel, or PDF if cache is enabled, or to HTML, CSV,
or XML (Excel) if cache is disabled.

Sorting. Sorts data in ascending or descending order.

Pivot. Lists the fields available to create a Pivot table.

Window Type. Shows windows as cascade or tabs.

Send as Email. Enables you to save the current changes and send a report as email.

Print. Prints all records or filtered-only records.

Advanced Tools. Accesses the Chart/Rollup, Pivot, and Grid Tools.

Filter. Opens the Filter Selection dialog box.

Calculations. Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct,
% of Total.

Chart. Converts a report to a pie, line, bar, or scatter chart.
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Visualize. Adds data visualization bars to a report.

Rollup. Performs rollup on data.

Comments. Adds comments.

Restore Original. Restores the In-Document Analytics enabled report to the default
state specified in the report procedure.

Save Changes. Saves the current changes.

Accordion. Produces accordion reports.

Grid Tool. Opens the Grid Tool dialog box.

Colors Tab

Use the Colors tab to select colors for various objects on the report. 

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page
text.

Font. Opens the Color dialog box, where you can select the font color.

Background. Opens the Color dialog box, where you can select the background color for the
page text.

Row Selection. This area contains options to set the colors that appear when you point to or
select a row on the report.

Hover. Opens the Color dialog box, where you can select the color that the row becomes
when you hold the mouse over the row.

Selected. Opens the Color dialog box, where you can select the highlight color that the row
becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

Positive. Opens the Color dialog box, where you can select the color for a data visualization
bar that represents a positive number.

Negative. Opens the Color dialog box, where you can select the color for a data
visualization bar that represents a negative number.
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Calculations. This area contains options to set the colors for values in a calculation.

Font. Opens the Color dialog box, where you can select the font color for the calculation.

Background. Opens the Color dialog box, where you can select the background color for the
calculation.

Menu. This area contains options to change the color of the menu.

Normal

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus.

Background. Opens the Color dialog box, where you can select the background color for
the column menus.

Border. Opens the Color dialog box, where you can select the color for the border of the
column menus.

Hover

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus when you point to them.

Background. Opens the Color dialog box, where you can select the background color
that appears behind options on the column menus when you point to them.

Advanced Tab

Note: Cache is enabled when you select as the output type, and click Pages On Demand on the
Format tab, in the Navigation group.

The Advanced tab contains the following options:

Cache. Enables a report to cache the data in a binary file and return the data to the output
window in pre-set increments.

Rows Retrieved. Select the number of rows retrieved in the output. The default value is
100.

Security. This area allows you to set a password to access the report and enable expiration by
date or by days. This option is only available for the reports that have enabled an In-Document
Analytics report output.
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Note: When setting security options for interactive reports, be aware that security options can
be set for each individual component on the canvas, but only one password can be set for the
entire document.

Freezing Column Headings in Interactive Reports

When working with interactive reports that use In-Document Analytics, you can freeze column
headings. The Freeze option in the GUI tools allows you to define a scroll area within the data
of your report and lock the column heading titles in place, enabling you to scroll through the
data within the container. Report headings, footings, and grand totals are also locked, so that
these also stay in view while you scroll the data in your report. This is particularly useful when
you are creating a large report, for which there may be multiple pages.

When you enable the column title freeze feature and run your report, a thin scroll bar displays
to the right side of the report, as shown in the following image.
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When you mouse over the thin scroll bar, it turns into a full scroll bar, making it easier to scroll
through your report data. This scroll bar is shown in the following image.

If your report has more columns than can fit in the output container, you can employ the
horizontal scroll bar at the bottom of your report.

Note: Scroll bars do not display if there is no scrollable data. Thus, if the data displayed fits
the size of the container, scroll bars do not display.

You can enable the column heading freeze feature for interactive reports in the GUI tools using
the Freeze button on the Format tab of the ribbon, in the Navigation group. Enabling the Freeze
option will add HFREEZE=ON in the stylesheet section of the report procedure, as shown in the
following example.
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ENGINE INT CACHE SET ON
SET PAGE-NUM=NOLEAD
SET SQUEEZE=ON
-DEFAULTH &WF_HTMLENCODE=ON;
SET HTMLENCODE=ON

SET HTMLCSS=ON
-DEFAULTH &WF_EMPTYREPORT=ON;
SET ARGRAPHENGINE=JSCHART
SET EMPTYREPORT=ON
SET EMBEDHEADING=ON
SET GRAPHDEFAULT=OFF

-DEFAULTH &WF_SUMMARY='Summary';
-DEFAULTH &WF_TITLE='WebFOCUS Report';
TABLE FILE wfretail82/wf_retail_lite
SUM WF_RETAIL_LITE.WF_RETAIL_SALES.COGS_US
WF_RETAIL_LITE.WF_RETAIL_SALES.DISCOUNT_US
WF_RETAIL_LITE.WF_RETAIL_SALES.GROSS_PROFIT_US
WF_RETAIL_LITE.WF_RETAIL_SALES.REVENUE_US
WF_RETAIL_LITE.WF_RETAIL_SALES.MSRP_US
BY WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.STATE_PROV_NAME
ON TABLE PCHOLD FORMAT AHTML
ON TABLE ROW-TOTAL 
ON TABLE NOTOTAL
ON TABLE SET CACHELINES 100
ON TABLE SET AUTOFIT OFF
ON TABLE SET GRWIDTH 1
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/ibi_themes/Warm.sty,$
TYPE=REPORT, TITLETEXT=&WF_TITLE.QUOTEDSTRING, 
SUMMARY=&WF_SUMMARY.QUOTEDSTRING, ARGRAPHENGINE=JSCHART, HFREEZE=ON, $
ENDSTYLE
END

-RUN

Once you have enabled the column heading freeze feature, you must run your report to view
the report with scroll bars.

Procedure: How to Freeze Column Titles in Interactive Reports

You can freeze column headings in your interactive reports.

1. Open InfoAssist.

2. Build your report.

3. Set the output format to HTML Analytic Document.

4. On the Format tab, in the Navigation group, click Freeze.

5. Run the report to view the frozen column titles.
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6. A scroll bar displays, enabling you to scroll through your data, vertically, as shown in the
following image.

Note: If you have numerous columns in your report, you can employ the horizontal scroll
bar at the bottom of the report.

Interactive Charts

Charts are graphical representations of data, showing trends, tendencies, and even possible
predictions. A chart often conveys meaning more clearly and effectively than data displayed in
tabular form. Charts show summaries on a higher level, giving you a better view of your most
important data.

A chart enables you to visually communicate quantitative information. Using a chart, you can
give data a shape and form, and reveal patterns and relationships among many data values. A
chart can highlight anomalies that require further investigation.

It is important that you choose a chart that is appropriate for your data. InfoAssist provides a
complete chart library of both basic and advanced charts. You can choose from a wide variety
of charts to best represent the data that you want to display.

In InfoAssist with In-Document Analytics enabled, you can create an interactive chart, change
the type of chart, and run the chart to take advantage of the tools that are available to you for
online or offline analysis.
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Interactive charts support the use of HTML5 extensions, which are user-supplied, custom chart
types that access resources external to Web Query.WebFOCUS. For details on the structure of
an extension and the steps for creating your own, as well as the process for adding it to the
chart library, see the Adding Your Own Chart Types to the Chart Library chapter in the Creating
HTML5 Charts With WebFOCUS Language manual.

If you are working with an AHTML chart that does not have the new chart properties
(specifically, non-bucket AHTML charts), you will encounter problems if you change the chart
type to one of the following chart types using the Advanced Chart tool at run time:

Tag Cloud

Funnel

Pyramid

Waterfall

Histogram

Radar Line

Radar Area

3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is
an AHTML bucket chart. These chart types are available under the following circumstances:

When the original chart is a non-bucket chart

When the chart is created from a tabular report

Interactive Dashboards

You can create an interactive dashboard by inserting multiple content types, such as reports,
charts, images, and text, into a document. It will run any report or chart using the In-Document
Analytics output format, even if the report or chart itself is not interactive.

You can also insert interactive prompts into a document to act as filters for the reports and
charts on the dashboard, as well as cascading (chaining) prompts to populate them based on
the selections from the previous prompts.

The output format of the interactive dashboard must be HTML Analytic Document or PDF
Analytic Document in order to add interactive dashboard prompts.
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Analytic Document Prompts

The Analytic Document prompts group contains buttons that insert components in your
dashboard. This group is only visible when the output format of the dashboard is set to HTML
Analytic Document or PDF Analytic Document. You can access these options from the Insert
tab, in the Analytic Document Prompts group.

The following are the types of prompts that you can use to apply filters to a dashboard:

Drop Down. Inserts a drop-down prompt placeholder in the upper-left corner of the canvas.

List. Inserts a list prompt placeholder in the upper-left corner of the canvas.

Checkbox. Inserts a check box prompt placeholder in the upper-left corner of the canvas.

Radio Button. Inserts a radio button prompt placeholder in the upper-left corner of the
canvas.

Text. Inserts a text area prompt placeholder in the upper-left corner of the canvas.

Note: The display of values populated in the prompts is dependent on the data setting. For
example, if sample data is turned on, then the prompts will show sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

Target Reports

When you bind a field to an Analytic Document prompt, the default target report is the report
from which you dragged the field. You can add or remove target reports from the prompt
through the Analytic Document Options dialog box.

A report must meet one of the following requirements to be a target report:

The report must contain a field with the same name as the source field (actual field name
or AS name).

The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title
and the title is changed, the report is automatically removed as a target.

Procedure: How to Add an Analytic Document Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and
binding a single prompt to one of the fields of the report.
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With InfoAssist in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type, or click PDF
Analytic Document.

2. On the Insert tab, in the Reports group, click Report.

A placeholder appears on the canvas.

3. Drag fields onto the canvas, or into the Query pane, to create the report and start building
the dashboard.

4. On the Insert tab, in the Analytic Document Prompts group, select a prompt type, such as
Drop Down, List, Checkbox, Radio Button, or Text.

The prompt type you selected now appears in the upper-left corner of the canvas. If the
report is located in the upper-left corner of the canvas, you will have to drag the prompt off
the report.

5. Select the report and bind one of its data source fields to the prompt in one of the
following ways:

Query pane: Select the report. From the Query pane, drag the field that you want to
bind onto the prompt.

Report on the canvas: Click the report on the canvas. You can now edit it. Highlight
the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

Note: Once a prompt is added to the canvas, the document is locked in an In-Document
Analytics output format, and you cannot change the format. To switch to a non-interactive
output format, you must remove all prompts.

Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an interactive dashboard. Each report can have
multiple prompts associated with it.

Procedure: How to Build a Dashboard With Multiple Reports

The following procedure describes how to set up Analytic Document Prompts for two reports on
a dashboard. In the example that is used, the first report contains information about the
categories of electronics products sold in various regions. The Product,Category field will be
bound to a group of radio buttons. Each radio button will represent a particular product
category of electronics. When you select a radio button for a product category, for example,
Accessories, the report will be filtered by your selection.
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The second report contains information about the gender and geographic location of
electronics consumers. The Gender field will be bound to a drop-down list. The list will display
the values, F (female) and M (male). When you select a gender from the drop-down list, the
report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.

2. Create an interactive dashboard by adding two reports with the following components,
respectively:

Report 1:

Product,Category

Store,Business,Region

Discount

Gross Profit

Report 2:

Gender

Customer,Continent

Product,Category

3. On the Insert tab, in the group, add the following prompts to the dashboard, positioning
them relative to each respective report.

Radio Button: This prompt will be used for Report1.

Drop Down: This prompt will be used for Report2.

4. Right-click the radio button prompt for which you want to bind a field to and click
Properties.

The Analytic Document Prompt Properties dialog box opens.

The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2)
that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you
want to bind a prompt.
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In this example, the radio button list (radiobutton_1) has been selected as the prompt for
the region report (Report 1), as shown in the following image.

The next step describes how to bind the Product,Category field from the region report to
the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the prompt.

In this example, the Product,Category field has been selected for the radio button list
(radiobutton_1), as shown in the following image.

Note: You can optionally specify an ascending or descending sort order for the current
scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
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In the following image, the radio button list is bound to the Product,Category field. It
displays all product categories by which you can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to
the drop-down list prompt.

8. Right-click the Drop Down prompt for which you want to bind a field and click Properties.

The Analytic Document Prompt Properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the
Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to
which you want to bind a prompt.
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The next step describes how to bind the Gender field from the gender report to the drop-
down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the
prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets
list and Report1 (region report) appears in the Candidate Reports list.

Note: To move a report from the Candidate Reports list box to the Targets list box, select
it and click the Add to List arrow. To remove a report from the Targets list box, select it
and click the Remove from List arrow. You can select multiple reports by holding down the
Ctrl key and clicking each one.

11. Click OK.
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The prompt is now bound to the Gender field on the dashboard. You can now filter the
gender report by female or male, as shown in the following image.
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The final dashboard displays, as shown in the following image.

Procedure: How to Change the Field

You can change the field to which the prompt is bound.

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and
bind a prompt to a field.

2. Right-click the prompt that you want to configure, and click Properties.

The Analytic Document Prompt Properties dialog box opens.

3. From the Field menu, select a different field.

A warning message alerts you that changing the source field for the prompt will remove the
existing prompt and any dependent (child) prompts from the cascades.

4. Click OK to close the warning.

5. Click OK to close the Analytic Document Prompt Properties dialog box.

The prompt is updated with the new source field.

Procedure: How to Change the Filter Condition

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and
bind a prompt to a field.
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2. Right-click the prompt that you want to work with, and from the shortcut menu, select
Properties.

The Analytic Document Prompt Properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the prompt. The options
are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater
than or equal to.

4. Click OK.

The filter condition is applied to the prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1. Create an interactive dashboard in Document mode, or open an existing dashboard
containing at least one report, and add at least two prompts.

2. Bind the fields to prompts that you have added.

Procedure: How to Cascade Prompts

When you have more than one prompt on the canvas, you can cascade prompts to populate
them based on the selections of the previous prompts. Cascading prompts have a parent-child
relationship, in which the parent filters the available options of the child.

A prompt can be the parent of more than one other prompt, but cannot be a child of more than
one prompt.

1. Create an interactive dashboard in Document mode, or open an existing dashboard, and
bind at least two prompts to fields.

2. Right-click the prompt that you want to configure, and click Properties.

The Analytic Document Prompt Properties dialog box opens.

3. Click Cascades.

By default, a cascade named Cascade1 appears in the Cascades section of the Analytic
Document Prompt Properties dialog box.

You can click the Create a new cascade  button to create a new cascade.

You can click the Delete selected cascade  button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.
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Note: You can remove prompts from the Selected Prompts list box by selecting them and
clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and
6.

By default, the hierarchy of the prompts is determined by the order in which they are
added to the Selected Prompts list. The cascade of the prompts is from top to bottom.
The prompts that come first in the Selected Prompts list are the parents of the lower
prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt
list box and clicking the Move Up and Move Down arrows.

9. Click OK.

The cascade is created.

10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the
one that filters the report.

Working With Interactive Content

Using the power and flexibility of In-Document Analytics, you can work with interactive content
online or offline (disconnected from any servers) in a unique browser session within your
environment. Reports, charts, and dashboards, which are comprised of one or more interactive
reports or charts, can be distributed or emailed to you, or accessed from the WebFOCUS Home
page. You can interact with these items in an environment that supports discovery and
exploration, giving you customized content, delivered right to your desktop or mobile device.

Interactive content is created and distributed in your environment by developers. When this
content is saved by the developer with an analytic output format, you can leverage the
functionality of In-Document Analytics by creating new reports and charts that show aspects of
your data that you otherwise might not notice. For example, you can access interactive content
and add reports and charts to maximize your analysis. You can drill through to other reports
and charts or utilize the Auto Drill functionality to navigate the hierarchy of your data. You can
change the chart type or access other formatting options that are available to you. This gives
you the flexibility of analyzing your data in different ways, including the ability to export data
right from the interactive component to continue your analysis using tools such as Microsoft
Excel and HTML.
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Developers share these interactive reports, charts, and dashboards with users for the purpose
of analyzing and reviewing data and informational trends. For example, you may receive a
report or chart that shows a pattern in your data. You can dive deeper into your analysis by
creating new reports or charts from this content, enabling you to view different scenarios as
you navigate your interactive content.

The interactivity of the content is supported by standard Graphical User Interface (GUI) options
that enable you to perform tasks quickly. For example, the Ellipsis menu offers options for
creating new items, as well as printing and exporting. The hamburger menu allows you to
return from maximized view. The following tools will enable you to effectively navigate In-
Document Analytics interactive content.

You can use the options on the vertical Ellipsis menu to perform some of the basic
commands, including Export, as well as other options shown in the following image.

You can use the following options on the Ellipsis menu to alter the component:

New. Creates a new report or chart that is based on the fields that you had selected for the
original artifact. If your component is a report, a new report will be created. Similarly, if your
component is a chart, a new chart will be added.

Edit. Edits the contents of the existing report or chart. Brings up the Chart tool where you can
make alternate selections.

Duplicate. Creates a copy of the existing component, which you can use as a template for
creating a contrasting artifact. This item is placed in the Analysis panel where it can be viewed
and modified.
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Export. Exports the underlying data or image for the current component. For reports, you can
export in Excel, CSV (comma delimited), and HTML format. For charts, you can export to Excel,
CSV (comma delimited), and PNG (image) format.

Print. Prints your report or chart through your browser.

Save Changes. Saves a copy of your chart output, in its current state, to the Downloads folder
on your machine. The default name of the output file is ARhtml.html, and includes a
Coordinated Universal Time (UTC) date/time stamp.

Restore Original. Returns your report or chart back to its original status.

When you create a new report or chart from an interactive component, it displays in the
Analysis panel, where you can interact separately with the new component. This panel appears
to the right of the screen. The Analysis panel is shown in the following image.

Using the Analysis panel, you can review unique scenarios as you build them, giving you a
broader view of your data by allowing you to compare different outcomes. You can also change
chart types and lock and unlock results. This is used in cases where you want to avoid
manipulating the result in any way. You can duplicate any of the artifacts in the Analysis panel
by clicking Duplicate on the Ellipsis menu. This allows you to perform comparative analyses of
a specific component by copying an existing artifact. You can also edit artifacts in the Analysis
panel by clicking Edit on the Ellipsis menu. This opens the Chart tool, where you can modify
your selections for the current component.
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You can also change the chart type for the original chart or on any new charts that you create,
as shown in the following image.

You can develop something progressive for your enterprise using these tools and functionality.

For primary components, as well as those in the Analysis panel, you can maximize your content
by clicking the maximize button, as shown in the following image.
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When your interface is maximized, you can return to the original view or exit full screen by
clicking the hamburger menu, as shown in the following image.

When your interface is not in maximized mode (default), the toolbar has a maximize button, as
well as a button to quickly change the chart type, which applies only to a chart component.
There is also a vertical Ellipsis menu that allows you to navigate to additional options. These
options are shown in the following image.

You can also use sort column indicators when you want to sort data in a report component.
You can sort a column in ascending and descending order. When you sort a column, a
corresponding indicator appears within the column title, as shown in the following image.
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In this example, the Gross Profit data is sorted in ascending order, from lowest to highest. If
you click the arrow again, the column sorts in descending order, from highest to lowest. If you
click the arrow again, it returns to the default arrow that points in both directions, indicating
that no sort has been applied, as shown in the following image.

When working with charts, you can change the chart type to see your data differently. For
reports, you can use the Column menu to create Chart Rollups or Pivot tables and you can use
the Cell menu to highlight items. You can use these options on the initial report, chart, or
dashboard that is distributed to you, or from any of the new components in the Analysis panel.
If your report developer has enabled the following features, you can also navigate different
levels of your data (for example, a hierarchy or another report) using Multi Drill, Auto Drill or
Auto Linking. These links appear as blue, underlined hyperlinks when you hover over an area of
a chart or select an option from a list, as in the case of a report. These links can be clicked as
you are navigating the hierarchy of your data or drilling through to a different item in your
interactive content.

The Multi Drill functionality enables the interactive content developer to create multiple drill
down links on a data field in a report or chart. This is useful when custom links are beneficial,
such as a link to a website, other visualizations, or additional reports. If your interactive
content developer has enabled it, Auto Drill lets you navigate through different levels within the
dimension hierarchy of your data source. This allows you to review the underlying data for a
particular area, and move through the structure of your data source based on your information
needs. When working with interactive content, the basic functionality of Auto Drill produces
different results. For example, you can use Auto Drill functionality in interactive content to drill
up or down within the hierarchies of your data for additional analysis. However, because the
interactive content refreshes to display a new report or chart when you drill up or down, any
content you create from the Chart Rollup menu will disappear. This also applies to any new
content that you create using the New option on the Ellipsis menu in an existing report or
chart.
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If enabled, Auto Linking makes it easy to connect reports and charts in your development
environment, expanding the reporting capabilities of your organization. Using Auto Linking, you
can dynamically link HTML reports, interactive reports, and HTML5 charts with a single chart of
any format, based on their common sort (BY) fields and parameters referenced in any filters.

When you create new reports and charts from interactive content in a browser session, each
new piece of content will be given a unique, sequential identification number that enables you
to view and manage what you create. This identification number that displays at the top left of
the new report or chart, is incremental, and automatically assigned. However, it may not be
consecutive.

In addition, when you are adding new information, for example, multiple reports and charts,
into the Analysis panel, you cannot save each instance of your analysis as an end-user. Each
session is dedicated to the current analysis only. If any of your artifacts contain multi drill or
auto drill links, for example, you can interact with these at run time.

Procedure: How to Create a New Report or Chart (as an end user)

1. Click the link or distributed attachment to open the interactive content. Optionally, open
the interactive content from the WebFOCUS Home page.
The interactive content displays.

2. Click the Ellipsis menu and then click New.
The Chart Tool opens, as shown in the following image.

3. From the left pane, select the data values that you want to include in the new report by
placing them in the relevant field container.

4. Click the check mark, , to close the report or chart to accept the selections and add it
to the Analysis panel.
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Your new component now appears in the Analysis panel, as shown in the following image.

Note: This works the same way for new reports, with a label of Report1, Report2, etc.

Procedure: How to Export the Underlying Data (or Image) for a Report or Chart

1. Click the link or distributed attachment to open the interactive content. Optionally, open
the interactive content from the WebFOCUS Home page.
The interactive content displays.

2. On the Ellipsis menu, click Export, as shown in the following image.
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3. From the left pane, select an output type for the export, as shown in the following image.

4. Click Export to export the data from the component.

5. In your local drive, open the Downloads folder to locate the downloaded file.

6. Open the file in the relevant application (for example, Microsoft Excel or a browser).

Interactive Content Usage Considerations

As you develop or interact with content that uses In-Document Analytics, you should reference
the following usage considerations.

The following notes apply to browser support.

Active PDF (APDF) is an In-Document Analytics Legacy style output format. It is not
supported in Microsoft Edge®, since APDF requires the Adobe Reader plug-in that supports
Flash Player.

ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Any In-Document
Analytics feature that requires the use of ActiveX controls is therefore not available in
Microsoft Edge. These include the following, which are accessible in other browsers at run
time, using the column drop-down menu on an interactive report:

Send as E-mail (supported only in Internet Explorer)

Save Changes (supported only in Internet Explorer)

Export to XML (Excel) when active cache is disabled

If you are using a Firefox® browser and you export an AHTML report to Excel, the file
extension that displays is incorrect (for example, .xls.xls). You can override this default
value using the settings of the browser. Specifically, if you click the Always ask me where to
save files radio button, which is located under Options, you will be prompted, upon
download, to either open or save the file. You can then provide a name and extension for
the file.
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The following notes apply to interactive reports.

At run time, when fields are added to, or removed from, a report that includes drilldowns
that pass parameter values, the drilldowns are disabled. This is because the parameter
values that are passed may no longer apply.

If multiple report components with different security passwords are included in an AHTML
document, the password for the last report component is used.

Interactive reports employ left and right cell padding, by default. This enables you to view
the report consistently, without the concatenation of any values or spacing issues related
to the cell padding. In cases where these settings are not defined in the StyleSheet, the
default settings for the left and right cell padding are used.

By default, the name specified in the Master File displays to identify a column in an
ACROSS group on a tabular report that has only one display field. With the following SET
command, you can display the title specified in the Master File, instead of the name, to
identify the column:

SET ACRSVRBTITL = ON

It derives the title from the TITLE attribute in the Master File (for example, TITLE = 'Product
ID'). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD =
PCD).

The Sort Ascending, Sort Descending, and Restore Original options are accessible on a
column drop-down menu on a report. When cache is enabled on the report, the Restore
Original option does not return the report output to its original state after sorting the data.
Instead, you receive the following message: Warning: Original sort could not be determined.

When using interactive content in Cache Mode, filtering may not work properly if the content
contains a text field (for example, TX50). As a workaround, consider using an alphanumeric
field (for example, A50).

The following notes apply to interactive charts.

When working with filters in an AHTML chart, certain filtering options do not display if you
have only one column on which to filter and it has a decimal format which includes a
decimal point. In this case, the Filter Chart and Exclude from Chart filtering options are not
available in the chart tooltip at run time.
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As of Release 8.2 Version 02, the new chart attribute syntax has been applied to the
following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and
Pyramid. This process adds additional relevant field containers for these chart types, which
can be used to specify fields in a specific area of the chart. For example, Horizontal Axis,
Color, and Tooltip are field containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type. For more information on
the underlying syntax used to create each chart type, see Creating HTML5 Charts With
WebFOCUS Language.

When you run a chart, the output displays a chart toolbar with a number of options that you
can select. These options are represented by icons. The chart toolbar provides an
Aggregation icon that allows you to select the aggregation method (that is, the type of
calculation, such as Sum or Avg) that will be used on the selected data in the chart.

If you run a chart that does not have a measure field to which an aggregation method can
be applied, the Aggregation icon:

Appears on the chart toolbar, but cannot be selected.

Displays None as the aggregation method. None is dimmed on the label. It indicates
that there will be no aggregation performed on, or applied to, the selected data in the
chart.

Once you run the chart with data that applies to an aggregation method, the Aggregation
icon is activated. Its label reflects the aggregation method currently in use (for example,
Sum).

The new chart attribute syntax has been applied to the following chart types: Dual Bar and
Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional
relevant field containers for these chart types, which can be used to specify fields in a
specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field
containers that are part of the new chart attribute syntax.

In InfoAssist, specific field containers display for each chart type.

The following note applies to exporting from content using In-Document Analytics.

If you create a report that contains ACROSS sort fields, and you attempt to export the data
using the Excel, CSV, and XML(Excel) options, the ACROSS column titles and field values
are not included in the exported content. The same is true for the report headings and
footings.
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The following note applies to tools available from your interactive content.

The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when
cache is enabled.

The following note applies when using the Cache option.

Date-time format fields are not supported.

The following notes apply when using the Export to Excel functionality.

When using the Export to Excel option while creating and generating a report with cache
enabled, the request will be generated in XLSX format, rather than EXL2K. This applies to
the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

The export behavior is controlled by the WebFOCUS Reporting Server. When the export is
performed, an Office Open XML document is produced, which you can download and save
in the required format (the default is .xlsx).

When using the Export to XML (Excel) option with cache disabled, the export behavior is
controlled by the active JavaScript layer. When the export is performed, a Microsoft Office
XML document is produced, which you can download and save in the required format (the
default is .xls). This applies to the following browsers: Microsoft Edge, Internet Explorer,
Firefox, and Chrome.

The following note applies when using mobile devices.

The Chrome browser "Force enable zoom" Accessibility setting on Android mobile devices
overrides a website request to prevent zooming. If this setting is enabled when executing
an AHTML report on an Android mobile device using Chrome, it interferes with active report
functionality, such as Freeze Column and manual resizing. The Accessibility setting needs
to be disabled for reports to be fully functional.

Running Content in Full-Screen Mode

When you run interactive content in maximized (full-screen) mode, there are a number of
navigational features that you can use. For example, you can change the position of report and
chart components in full-screen mode using drag and drop. To drag and drop, simply click the
toolbar of any component and, holding the mouse, drag the object to the desired position.

In this mode, output is responsive and automatically adjusts when the width of the window is
wider than its height. This is particularly useful when you have a number of components in
view. In addition, full-screen mode displays a taskbar at the bottom of the screen, with an item
for each report or chart component. The component currently selected on the screen is
highlighted in the taskbar.
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When switching from one dashboard tab to another, each page reflects the correct
components that are currently available on that page. You can use the page taskbar at the
bottom of the screen to review the report and chart components on the page.

You can also hide a component in full-screen mode. This enables you to hide a component
from display, particularly in cases where that object is not currently needed or is irrelevant. If
you wish to bring a hidden component back into view, you can click the corresponding item in
the taskbar, as shown in the following image.

In cases where you have spawned components (for example, items created using the chart,
pivot, rollup, or duplicate options) in full-screen mode, they are numbered in the page taskbar
that corresponds to the table/chart component. The number is shown in the right corner, and
an item is appended to the right of it for the spawned component. The number indicates how
many components have been spawned from that component item. When you click an item in
the taskbar, the window is split to display the spawned components along with the currently
displayed components.

You can also drag and drop a component to the left or right of another component (in
landscape mode) or above or below another component when working in portrait mode. You
can reposition a table/chart component using the left or right arrows in the toolbar. This
makes it easy to move just one component to the left or right in a single motion.
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Another feature of full-screen mode is the ability to display report and chart components side
by side while in full-screen mode. You can click on a component button while holding the Ctrl
key to display multiple components at a time on the screen. The screen splits evenly to fit all
selected component. If you click an item in the taskbar, the corresponding component is
displayed in maximized (full-screen) mode and will occupy the full screen, as shown in the
following image.

Using the Options Menu to Perform Common Tasks

Each interactive report or chart that uses In-Document Analytics contains an Options menu that
you can use to modify the component further for advanced data analysis. In addition to
minimizing and maximizing the component, you can also change the type of chart used, and
access other options, such as Edit, Duplicate, and Print. 

Working With Interactive Content

48 



The following image shows the Options menu, expanded to show the options that are available
for an interactive chart component.

The Options menu includes the following:

New. Launches a Designer canvas, where you can place the data into corresponding buckets
to create a new component.

Edit. Opens the component in a modified Designer canvas so you can edit it.

Duplicate. Creates a copy of the component that you can modify.

Export. Exports the data for your report, table or chart to your Downloads folder. The supported
export options for charts include Data to Excel, CSV, and PNG. The supported export options
for reports include Excel, CSV, and HTML. In addition, when you filter an interactive component
during run time, you can choose to export all records or only the filtered records. You can also
multi-select different export options.

Print. Launches a window, with options that enable you to print the component. When you filter
interactive components during run time, you have the option to print the entire component or
only the filtered records. The Print button launches your browsers Print dialog box where, you
can set up your page for printing.

Save Changes. Saves your current chart output in its current state to the Downloads folder of
your machine with a default name of ARsave.html and a Coordinated Universal Time (UTC) date
time stamp.

Restore Original. Returns the component to its original state.
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To close the Options menu, click it a second time.

When you have duplicated or created a new report or chart from another one, the Options
menu on the duplicated item displays an option to close your component, as shown in the
following image.

Procedure: How to Create a New Component

1. Select New from the Options menu on an interactive component.

2. Drag a measure to one of the corresponding buckets for your component type, for
example, the Vertical bucket.

3. Drag a dimension to one of the corresponding buckets for your component type, for
example, the Horizontal bucket.

4. Continue to add the available measures and dimensions to your component. You can also
customize the component in the following ways:

Create a new calculation, and add the field to your component.

Use the corresponding options above the buckets to modify a chart.

Lasso data on the canvas to create a filter.

5. Click the checkmark button to save your component, and return to the original report or
chart.

Your new component now appears in the Analysis panel.

Procedure: How to Edit a Component

1. Choose a component that you want to modify.

2. Click the Options menu, and then select Edit. This returns you to the design canvas, where
you can modify your field selections, change your chart type, and more.

3. Click the checkmark button to save the changes.

Procedure: How to Duplicate a Component

1. Choose a component that you want to duplicate.

2. Click the Options menu, and then select Duplicate. A duplicate version of the original
component now appears in the Analysis Panel.

3. Optionally, lock the duplicate component, modify it by changing the chart type, exporting
the data, or printing the component.
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Procedure: How to Export the Data from an Interactive Component

1. Choose the component from which you want to export data.

2. Click the Options menu, and then select Export. The component opens in a new window
that contains options for your export.

3. Select the options that you want to use for the exported file. For example, you can select
Filtered only, which only exports the filtered data. You can also choose the output format.
For charts, select Data to Excel, CSV, or PNG. For reports, select Excel, CSV, or HTML.

4. Once you have selected your export options, click Export.

Note: All exported data is automatically sent to the Downloads folder.

Procedure: How to Save the Changes You Make to an Interactive Component

Click Save Changes from the Options menu to save the most recent changes to the interactive
component.

Note: Any saved changes are automatically saved to the Downloads folder, where you can
access the data that is stored with a file name of ARsave.html and a Coordinated Universal
Time (UTC) date time stamp. If you are working with a chart and you edit it or change the chart
type, the changes are automatically saved in the output file.

Procedure: How to Print an Interactive Component

1. Choose a component that you want to print.

2. Click the Options menu, and then select Print. The components opens in a new window.

3. Click the Print button, which opens the standard Print dialog box for your browser.

4. Select the print destination, page detail, copies, and other settings that you want to
configure, and then click Print.

The options available to you, as well as the format of your output are determined by the
browser you are using to access your content. In addition, results may vary depending on
whether you print in color or in black and white. This includes appearance of line weights
and fonts.

Specific browser considerations are highlighted below:

Printing landscape in Microsoft Edge results in a narrower display of the chart.

When printing charts in portrait, using Microsoft Edge, you are unable to resize the
chart using fit to page.

Chrome browsers only enable printing in landscape.
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In-Document Analytic Options for Reports

You can use a variety of menus and options when performing analysis of an interactive report
that uses In-Document Analytics. Depending on the style that you use, these options may be
different.

Designer Style Report Cell Menu Options

Using the Designer Style interactive report, the cell menu allows you to customize the display
of your report, while adding the ability to quickly add filters. The cell menu displays when you
click on each cell in a report. This enables you to highlight an individual value or a row or add
comments about this individual cell in your report. You can also reverse a previously
highlighted aspect. The cell menu is shown in the following image.

The Filter Cell option enables you to filter the report for just that row in the report. For example,
if you want to see Accessories, you would click on Accessories in the report to enable the cell
menu. In this case, the request returns just the values for Accessories, as shown in the
following image.
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You can subsequently remove the filter by clicking Remove Cell Filter, as shown in the following
image.

This returns the report to its original, unfiltered state.

Legacy Report Cell Menu Options

When you are working in an interactive report, that uses the Legacy style, the following data
cell options display.

Option Definition

Drill down Enables you to drill down one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Drill up Enables you to drill up one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Restore Original Restores the report to the default state specified in the
report procedure.

Auto Links Displays a list of target reports that are linked to the Auto
Link enabled report. This option displays for reports that
have Auto Linking enabled.

Comments Enables you to add comments about data in your report.
The result is an annotation that displays when you hover
over it at run time.

Highlight Value Enables you to highlight a particular value in your report.

Highlight Row Applies highlighting to the selected row in your report.
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Option Definition

Unhighlight All Removes any applied highlighting from values or rows in
your report.

Filter Cell Enables you to filter the output, showing only a selected
row of data.

Remove Cell Filter Removes any applied cell filters.

Using the Column Menu for Reports

The column menu displays when you click a column heading in a report. This provides you with
access to formatting tools, chart type options, and filters, giving you more control over what
displays in your report.

For a non-measure or dimension column, there are three primary sections to the column menu,
as shown in the following image.

You can customize each column in your report. For example, you may want to filter on specific
product categories while displaying column totals for others. This allows you to create and
customize your report column by column.

You can use the following information to identify column menu components as you build your
report:

Ascending. Sorts the selected column in ascending order.

Descending. Sorts the selected column in descending order.

Show Column Total. Displays the column total for the currently selected column. Column totals
display at the bottom of the report.

Hide Column. Hides the currently selected column. This removes the currently selected column
from view.
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Chart Rollup. Select a chart type and, optionally, specify an aggregation other than the default
value, Sum. Select a column for which to create the chart and click Create. The chart is
created in a separate dialog box, enabling you to interact with the chart using the chart
features and options.

Rollup. Use the Rollup option to select an aggregation for the currently selected column. You
can also select a Group By value, options for which include the list of different columns in the
report. Once you have made your selections, click Create to create the rollup, as shown in the
following image.

Pivot. Use the Pivot option to create a cross-tab Pivot table. You can select an aggregation for
the currently selected column. Next, specify a column value by which to group the report.
Indicate an Across value to create the across values in your table. Click Create to create the
pivot table, which displays in the analysis panel, as shown in the following image.

Note: The available group and across values include the dimension column values in your
report (for example, Product Category).
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Numeric Slider. If you are working with a measure value (for example, MSRP), you can use the
slider tool to narrow the values you want to display. The slider shows the lowest to highest
values in your measure, as shown in the following image.

You can specify a range of values by entering the values into the text boxes. This allows you to
specify a range of values for a specific measure. If a value falls outside of the range of the
data values, it will be crossed out, indicating that the value is invalid, as shown in the following
image.

Filter. Use the filter option to narrow the data in your report. The filter option allows you to
search on a value, or use the check boxes to select one or more values. You can use the
Select option to select all values in your data hierarchy. Click Clear to clear the selected
values. Once a filter is in place for a column, you can use the funnel-shaped icon, located next
in the column heading, to clear the filter. This icon is shown in the following image.
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If you are working with a date field, you can filter on a specific date using the filter control in
the column menu. The filter control enables you to filter on a specific date or a range of dates,
which you can indicate by holding the Ctrl key and clicking, while indicating the starting and
ending dates. The range of dates is highlighted after you make your selection. The calendar
filter is shown in the following image.

Note: When a calendar filter is specified, you can remove the filter by clicking the Remove Filter
icon at the top of the date column.

Highlight. Select Highlight to highlight select components of your report. For example,
Camcorder, Media Player, and Stereo Systems are highlighted in the following image.

Once the highlight filter is in place, you can remove it by clicking the Remove Highlight filter
icon.

For measures, there are two additional options:

Visualize. Adds visualization bars to, or removes them from, the selected column.
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% of Total. This is a calculation of the current value against the total for the values in a
column. When you click Create, a new column is added, showing the calculated values.

These options are shown in the following image.

Using Sort Column Indicators in Your Report

Interactive reports support the use of sort column indicators when you want to sort data in a
report. You can sort a column in ascending and descending order, giving you control over the
display of information in your report. The indicator that shows how a column has been adjusted
by a previous action shows to the right of the column, as shown in the following image.

As shown above, the selected column is sorted in ascending order, where the values in the
column are sorted from lowest to highest. If you click the arrow again, the column will be
sorted in descending order, where the values are sorted from highest to lowest. If you click the
arrow again, it will return to the default arrow that points in both directions, indicating that no
sort has been applied.
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Formatting Interactive Reports from the Column Menu

The column menu opens when you click a column heading in an interactive report. Here, you
can access the formatting tools, chart type options, and filters that enable you to control what
displays in your report.

For a non-numeric or dimension column, there are three primary sections to the column menu.
These include sorting, charting, and filtering options. These are shown in the following image.

You can customize each column in your report. For example, you may want to filter on specific
product categories while displaying column totals for others. This allows you to create and
customize your report column by column.

You can use the following information to identify column menu components as you build your
report:

Ascending. Sorts the report column in ascending order.

Descending. Sorts the report column in descending order.

Show Column Total. Displays the column total for the currently selected column. Column totals
display at the bottom of the report.

Hide Column. Hides the currently selected column. This removes the currently selected column
from view.

Chart Rollup. Enables you to select a chart type and, optionally, specify an aggregation other
than the default value, Sum. Select a column for which to create the chart and click Create.
The chart is created in a separate dialog box, enabling you to interact with the chart using the
chart features and options.
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Rollup. Allows the use of the Rollup option to select an aggregation for the currently selected
column. You can also select a Group By value, options for which include the list of different
columns in the report. Once you have made your selections, click Create to create the rollup,
as shown in the following image.

Pivot. Enables you to use the Pivot option to create a cross-tab Pivot table. You can select an
aggregation for the currently selected column. Next, specify a column value by which to group
the report. Indicate an Across value to create the across values in your table. Click Create to
create the pivot table, which displays in the analysis panel, as shown in the following image.

The available group and across values include the dimension column values in your report (for
example, Product Category).
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Numeric Slider. Enables you to use the slider tool to narrow the values you want to display if
you are working with a measure value (for example, MSRP). The slider shows the lowest to
highest values in your measure, as shown in the following image.

You can specify a range of values by entering the values into the text boxes. This allows you to
specify a range of values for a specific measure. If a value falls outside of the range of the
data values, it will be crossed out, indicating that the value is invalid, as shown in the following
image.

Filter. Narrows the data in your report using the filtering capability. The filter option allows you
to search on a value, or use the check boxes to select one or more values. You can use the
Select option to select all values in your data hierarchy. Click Clear to clear the selected
values. Once a filter is in place for a column, you can use the funnel-shaped icon, located next
in the column heading, to clear the filter. This icon is shown in the following image.
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If you are working with a date field, you can filter on a specific date using the filter control in
the column menu. The filter control enables you to filter on a specific date or a range of dates,
which you can indicate by holding the Ctrl key and clicking, while indicating the starting and
ending dates. The range of dates is highlighted after you make your selection. An example of
the calendar filter is shown in the following image.

Note: When a calendar filter is specified, you can remove the filter by clicking the Remove Filter
icon at the top of the date column.

Highlight. Select Highlight to highlight select components of your report. For example,
Camcorder, Media Player, and Stereo Systems are highlighted in the following image.

Once the highlight filter is in place, you can remove it by clicking the Remove Highlight filter
icon.

For measures, there are two additional options:

Visualize. Enables you to add visualization bars to, or removes them from, the selected
column.

Working With Interactive Content

62 



% of Total. Presents calculation of the current value against the total for the values in a
column. When you click Create, a new column is added, showing the calculated values.

These options are shown in the following image.

Creating Content Using the Chart Rollup Tool

You can access the Chart Rollup Tool from the column menu in a Designer Style interactive
chart or report enabled. There are three tabs: Chart, Rollup, and Pivot. As you create charts,
rollups, or pivot tables, each artifact displays in the analysis panel.

You can use the Chart Rollup Tool to select multiple group fields to generate the chart, rollup
or pivot table.

For the Chart tab, you can select a chart type, an aggregation, and a column for the chart, as
shown in the following image.

Procedure: How to Use the Chart Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.

3. From the Chart Rollup tool, select a chart type.

4. Optionally, add an aggregation for the currently selected dimension.

5. Select a dimension or measure from the field list.

2. Creating Interactive Content With In-Document Analytics

In-Document Analytics User's Guide  63



6. Click Create.
The chart displays in the analysis panel. You can interact with the chart in the same way
as any other artifact.

For the Rollup, you can perform an aggregation on the current report column. You can also
select a Group By value, which lists all columns in the report, as shown in the following
image.

Procedure: How to Use the Rollup Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.

3. From the Chart Rollup tool, select the Rollup tab.

4. Optionally, select an aggregation to be applied to the selected column.

5. For the Group By field, select a dimension or measure for which to perform the rollup.

6. Click Create.
The Rollup displays in the analysis panel.

For Pivot tables, you can similarly select an aggregation for the currently selected column
in the report. You can select from the existing dimensions for the Group By and Across
fields, as shown in the following image.
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Procedure: How to Use the Pivot Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.

3. From the Chart Rollup tool, select the Pivot tab.

4. Optionally, select an aggregation to be applied to the selected column.

5. For the Group By field, select a dimension by which to group the table.

6. For the Across field, select another dimension that will display as an across field.

7. Click Create.

The Pivot table displays in the analysis panel.

Using Sort Column Indicators to Control the Display of Information in Your Report

In-Document Analytics ( IDA) reports support the use of sort column indicators when you want
to sort data in a report. You can sort a column in ascending and descending order, giving you
control over the display of information in your report. The indicator that shows how a column
has been adjusted by a previous action shows to the right of the column, as shown in the
following image.

As shown above, the selected column is sorted in ascending order, where the values in the
column are sorted from lowest to highest. If you click the arrow again, the column will be
sorted in descending order, where the values are sorted from highest to lowest. If you click the
arrow again, it will return to the default arrow that points in both directions, indicating that no
sort has been applied.
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Creating a Report with In-Document Analytics

As a developer, you can create effective, useful reports and share them easily using In-
Document Analytics (IDA). You can create reports in InfoAssist or App Studio, selecting the In-
Document Analytic format to enable sharing and access across your enterprise.

A report is used to show the intersections of data between rows and columns. Once created,
you can style your report, add headers, and footers, and apply other formatting options to
make your data stand out. When you have completed creating your report, you can set the
format of the report to In-Document Analytics to enable distribution and sharing of your report.
Using this format, you can interact with data, using analysis options similar to those found in
an Excel workbook. Since no connection to a server is required to view the data or use the
analysis options (for example, filtering, charting, and sorting), you can save and use the report
anywhere.

You can create a report using Report mode in InfoAssist or by using the Report Wizard in App
Studio.

Note: All reports display with HFREEZE ON, a feature that freezes the headings in your report,
in In-Document Analytics.

Procedure: How to Create an IDA report in InfoAssist

1. In WebFOCUS Designer, click the InfoAssist tab and then click Report. The Open dialog box
appears.

2. From the Open dialog box, select the data source that you want to use, and click Open.
The data source that you selected appears in the Data pane of the Resources panel.

3. Drag fields onto the canvas or into the Query pane to begin building your report.
A basic report is shown in the following image.

4. On the Home tab, in the Format group, select the HTML Analytic Document format.
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5. Optionally, run the report to verify its contents and accessibility.

6. Save the report to your repository for online or offline access.

Procedure: How to Create a report in App Studio

1. Open App Studio.

2. On the Home tab, in the Content group, click Report.
The Report Wizard opens, as shown in the following image.

3. Click Create Report.
The Report Wizard - Select Procedure Location window opens.

4. Navigate to where you want to create the new report and click Next.
The Select Data Source window opens.

5. Choose an application folder in the application folder tree, and select a Master File in the
Master Files list. You can select the Use Qualified Path check box if you only want to
display the data sources in the application folder and generate a qualified file name
reference.

6. Click Finish.
The Report Canvas and the Procedure View panel open.
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7. Double-click fields in the Object Inspector, or drag them onto the canvas to add them to
the report, as shown in the following image.

8. Format your report by using the options on the Report, Format, Data, Layout, Images,
View, Field, and Appearance tabs.

Note: The Field and Appearance tabs appear when you select a data column on the Report
canvas.

9. To enable In-Document Analytics format:

a. Click the Format tab.

b. Select the HTML Analytic Document format.
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This enables the Analytic Document Options tab, giving you the ability to set In-
Document Analytic report options.

10. To save your report, click Save on the Quick Access Toolbar, or click Save or Save As from
the Application menu.

Your report is now accessible by others in your enterprise, online or offline.

Creating an In-Document Analytics Report

An In-Document Analytics enabled report is a self-contained report that is designed for offline
analysis.

Procedure: How to Create an In-Document Analytics Report

With InfoAssist in Report mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click HTML Analytic Document or HTML
Analytic Document.

2. Populate the report with your data in one of the following ways:

Drag the dimension fields and measure fields onto the canvas.

Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

In-Document Analytics Report Menu Options

Menu options for an In-Document Analytics enabled report are described in the following table.

Note: The following options described in the table require the use of ActiveX controls. Since
Microsoft Edge does not support ActiveX technology, these options are not available in that
browser:

Send as E-mail

Save Changes

Export to XML (Excel) when cache is disabled

Option Definition

Sort Ascending Sorts the column in ascending order.

Sort Descending Sorts the column in descending order.
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Option Definition

Filter Filters the data. Options are:

Equals

Not equal

Greater than

Greater than or equal to

Less than

Less than or equal to

Between

Not Between

Contains

Contains (match case)

Omits

Omits (match case)
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Option Definition

Calculate Calculation types that you can apply to the column:

Clear

Clear All

Count

Distinct, which counts the number of distinct values within a
field

For numeric fields, you can also apply:

Sum

Avg

Min

Max

Count

Distinct, which counts the number of distinct values within a
field

% of Total

Chart Creates an In-Document Analytics enabled chart from the report.
Options are Pie, Line, Column, and Scatter.

Rollup Lists the fields available to create a table.

Pivot (Cross Tab) Lists the fields available to create a Pivot table.

Visualize Adds visualization bars to, or removes them from, the selected
column. The Visualize option is available for numeric data
columns.

Hide Column Suppresses the display of the selected column in the report.
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Option Definition

Show Columns Lists the names of the columns that are hidden in the report,
allowing you to individually restore a column.

Select the name of a specific column in the hidden columns list to
restore that column to the report.

Freeze Column Freezes the report at a particular point so that columns to the left
of the freeze point remain in view while the user scrolls through
the other report columns.

Note: If the report can be fully viewed in the browser window,
freeze is not applied. The Freeze column option is not available for
expandable report (Accordion) views.

Unfreeze All Unfreezes the columns.

Grid Tool Opens the Grid Tool, which you can use to change the column
order, select multiple columns to sort ascending or descending,
hide and show columns, add a calculation result to a column, and
add subtotals to the In-Document Analytics enabled report.

Chart/Rollup Tool Opens the Chart/Rollup Tool, which you can use to select multiple
group fields to generate the chart or rollup table. The Chart/Rollup
Tool contains a list of columns available in the In-Document
Analytics enabled report to add to Group By and Measure fields.
Drag the columns into the field that you want.

Pivot Tool Opens the Pivot Tool, which you can use to select multiple group
fields to generate the chart or pivot table. The Pivot Tool contains
a list of columns available in the In-Document Analytics enabled
report to add to Group By, Across, and Measure fields. Drag the
columns into the field that you want.

Show Records Opens the Show Records menu option to list the number of
records available for display per page in the report. Select a
number (for example, 10) to display, per page. Default displays the
number of records (lines) per page that is specified in the
WebFOCUS report procedure.
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Option Definition

Comments Options to display comments under cells or hide indicators for
comments in the In-Document Analytics enabled report output.

Send as E-mail Enables you to save the current state of the In-Document Analytics
enabled report and send the report as email.

Note: To use this feature, you must have ActiveX enabled in your
browser security settings.

This feature is only supported in Internet Explorer.

Save Changes Saves the current state of the In-Document Analytics enabled
report as an HTML file in the Downloads folder. Depending on your
browser settings, you can optionally save the file to a different
location on your local system.

Note: When you save an In-Document Analytics enabled report
using the browser Save as option, the report is saved in its original
default state. In the browser Save as dialog box, we recommend
that you select the Webpage, HTML Only save option to ensure
that the page is saved properly.

Export When cache is enabled, exports all records or filtered only records
to HTML, CSV, Excel, or PDF.

Note: cache is enabled on an In-Document Analytics enabled
report when you click Pages On Demand on the Format tab, in the
Navigation group.

When cache is disabled and with cases where a disconnected file
is used for offline analysis, exports all records or filtered only
records to HTML, CSV, or XML (Excel) and automatically places a
copy in your Downloads folder. This applies to the export of all
interactive output across all browsers. To use this feature, you
must enable ActiveX in your browser security settings.

Print Prints all records or filtered only records.

Window Displays reports in a cascade or separate tabs.
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Option Definition

Restore Original Restores the In-Document Analytics enabled report to the default
state specified in the report procedure.

In-Document Analytics Cell Menu Options

When you are working in In-Document Analytics enabled report format (legacy format), the
following data cell options display.

Option Definition

Drill down Enables you to drill down one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Drill up Enables you to drill up one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Restore Original Restores the In-Document Analytics enabled report to the
default state specified in the report procedure.

Auto Links Displays a list of target reports that are linked to the Auto
Link enabled report. This option displays for reports that
have Auto Linking enabled.

Comments Enables you to add comments about data in your report.
The result is an annotation that displays when you hover
over it at run time.

Highlight Value Enables you to highlight a particular value in your report.

Highlight Row Applies highlighting to the selected row in your report.

Unhighlight All Removes any applied highlighting from values or rows in
your report.

Filter Cell Enables you to filter the output, showing only a selected
row of data.
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Option Definition

Remove Cell Filter Removes any applied cell filters.

Configuring In-Document Analytics Report Options

You can configure In-Document Analytics enabled report options, including menu options,
based on user role, through the Analytic Document Options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the button.
The button is available when HTML Analytic Document or PDF Analytic Document is selected as
the output type.

The Analytic Document Options dialog box contains the following tabs:

General

Menu Options

Colors

Advanced

General Tab

Use the General tab to set common properties specific to In-Document Analytics enabled
reports.

The General tab contains the following options:

Display. This area contains options to set the window to cascade or tabs, and options to
freeze columns.

Window. Select the window setting. The options are Cascade and Tabs.

Note: You can use the Cascade or Tabs options to modify how the output window displays.
The Tabs option can be used with the Legacy style only.

Freeze Columns. Select the columns you would like to freeze. You can also select None.

Page Options. This area contains options to set the number of records per page, enable the
display of page information, edit the alignment, and set the location of the page information.

Records Per Page. Select or type the number of records that you would like to display per
page. The default value is 57.
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Display Page Information. Select this option to display page navigation information. Clear
this option to disable the display of page navigation information.

Alignment. Click the appropriate button to set the alignment of the page navigation
information. Options are Left, Center, and Right.

Location. Select the location for the page navigation information. The options are Top Row
and Bottom Row.

Chart Options. This area contains options that pertain to charts when the output format is PDF
Analytic Document.

Note: Chart Options do not display when the output format is HTML Analytic Document.

Legend (check box). Select this option to collapse the legend if necessary. Clear this
option if you do not want the legend to collapse.

Legend (menu). Select the location for the legend. The choices are:

Bottom Left

Bottom Center

Bottom Right

Menu Options Tab

Use the Menu Options tab to select a user type and which options to display in the menu. 

The Menu Options tab contains the following options:

User Type. The options are Power, Analyst, Basic, and Custom.

Power. This is the default user type. It enables all functionality.

Analyst. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original,
Save Changes, and Accordion.

Basic. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.

Custom. If you select a combination of options that does not match one of the existing
user types (Power, Analyst, Basic), the User level name that appears in the User Type
field is Custom. This is not a default user type or a selectable user type. It indicates
that options for this user do not match any of the existing user types.
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The options available according to user type include the following:

Show Records. Shows all records or specific numbers of records.

Freeze. Freezes and unfreezes columns.

Hide/Unhide. Hides and shows columns.

Export. Exports data to HTML, CSV, Excel, or PDF if cache is enabled, or to HTML, CSV,
or XML (Excel) if cache is disabled.

Note: If cache is disabled, the output is automatically sent to the Downloads folder.
This applies to all interactive outputs, across all browsers, as well as when you are
working with a disconnected file for offline analysis.

Sorting. Sorts data in ascending or descending order.

Pivot. Lists the fields available to create a Pivot table.

Window Type. Shows windows as cascade or tabs.

Send as Email. Enables you to save the current changes and send a report as email.

Print. Prints all records or filtered-only records.

Advanced Tools. Accesses the Chart/Rollup, Pivot, and Grid Tools.

Filter. Opens the Filter Selection dialog box.

Calculations. Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct,
% of Total.

Chart. Converts a report to a pie, line, bar, or scatter chart.

Visualize. Adds data visualization bars to a report.

Rollup. Performs rollup on data.

Comments. Adds comments.

Restore Original. Restores the In-Document Analytics enabled report to the default
state specified in the report procedure.

Save Changes. Saves the current changes.

Accordion. Produces accordion reports.

Grid Tool. Opens the Grid Tool dialog box.
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Colors Tab

Use the Colors tab to select colors for various objects on the report. 

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page
text.

Font. Opens the Color dialog box, where you can select the font color.

Background. Opens the Color dialog box, where you can select the background color for the
page text.

Row Selection. This area contains options to set the colors that appear when you point to or
select a row on the report.

Hover. Opens the Color dialog box, where you can select the color that the row becomes
when you hold the mouse over the row.

Selected. Opens the Color dialog box, where you can select the highlight color that the row
becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

Positive. Opens the Color dialog box, where you can select the color for a data visualization
bar that represents a positive number.

Negative. Opens the Color dialog box, where you can select the color for a data
visualization bar that represents a negative number.

Calculations. This area contains options to set the colors for values in a calculation.

Font. Opens the Color dialog box, where you can select the font color for the calculation.

Background. Opens the Color dialog box, where you can select the background color for the
calculation.

Menu. This area contains options to change the color of the menu.

Normal

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus.

Background. Opens the Color dialog box, where you can select the background color for
the column menus.
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Border. Opens the Color dialog box, where you can select the color for the border of the
column menus.

Hover

Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus when you point to them.

Background. Opens the Color dialog box, where you can select the background color
that appears behind options on the column menus when you point to them.

Advanced Tab

Note: Cache is enabled when you select HTML Analytic Document as the output type, and click
Pages On Demand on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

Cache. Enables a report to cache the data in a binary file and return the data to the output
window in pre-set increments.

Rows Retrieved. Select the number of rows retrieved in the output. The default value is
100.

Security. This area allows you to set a password to access the report and enable expiration by
date or by days. This option is only available for the In-Document Analytics enabled report
output.

Note: When setting security options for In-Document Analytics enabled reports, be aware that
security options can be set for each individual component on the canvas, but only one
password can be set for the entire document.

Using Paging to Navigate Pages in a Report

You can navigate between pages in an interactive report or grid (AHTML) using the page
navigation options in the pagination bar. These options make it easy to view large amounts of
data quickly, without scrolling. For stand-alone items, such as a single report that contains a
large amount of data, the pagination bar appears at the bottom of the container. When you are
creating a page that contains multiple reports, the pagination bar appears at the bottom of the
page container. 

An example of the pagination bar for a single interactive report are shown below.
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The pagination bar contains two components: a record count that dynamically changes as you
move between pages and a set of controls that you can use to advance pages, return to
pages, or enter specific page numbers. A pagination bar example is shown in the following
image.

The following table identifies the page controls that you can use to navigate between pages of
an interactive report.

Button Action
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Takes you to the first page of the report.

Takes you to a previous page of a report.

Indicates the current page number of the
report that you are viewing. You can click
this number, and enter a new number to
jump to a different page of the report.

Takes to you to the next page in the report.

Takes you to the last page of the report.

Controls in the pagination bar are contextual and become available as you move between the
pages of the report. If you create or receive a report that contains filters, the record
information and pagination reflect the filtered report, and may not reflect the total number of
records in the report. By default, each page displays 57 records, and right justifies the paging
controls. This pagination bar automatically adjusts to the size of the container, and changes
the display of information, when you minimize the report. An example of this behavior is shown
in the following image.

Page navigation options also display when users create new grid components offline.
Specifically, a new report component that is saved to the Analysis Panel displays with the
same page navigation options, as shown in the following image.
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If you are creating interactive reports using InfoAssist, you can customize the display of the
pagination bar, including the number of records shown, justification of page detail, and more.
On the Format tab, in the Features group, click Analytic Document Options.

Creating an In-Document Analytics Enabled Chart

An In-Document Analytics enabled chart is a chart that is designed for offline analysis. For
more information, see Report Overview.

Note: In-Document Analytics supports the use of HTML5 extensions, which are user-supplied,
custom chart types that access resources external to Web Query.WebFOCUS. For details on
the structure of an extension and the steps for creating your own, as well as the process for
adding it to the chart library, see the Adding Your Own Chart Types to the Chart Library chapter
in the Creating HTML5 Charts With WebFOCUS Language manual.

Procedure: How to Create an In-Document Analytics Enabled Chart

With InfoAssist in Chart mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click HTML Analytic Documentor PDF Analytic
Document.

2. On the Format tab, in the Chart Types group, click the button of the chart that you want to
create. Bar chart is the default.

The chart appears on the canvas.
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3. Populate the chart with your data in one of the following ways:

Drag the dimension fields and measure fields onto the chart.

Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

The following image shows an HTML5 pie chart that displays the sum of the values in the
Quantity Sold field by Product Category.

In-Document Analytics Options for Charts

Options for an In-Document Analytics enabled chart (legacy) are described in the following
table.

Note: For charts that employ the new attribute syntax, only the following four icons display:
More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the
Remove Filter icon displays.
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Option Definition

More Options New. Creates a new instance of the chart. This option is available only when the
chart is created from a column menu on a tabular report.

Group By (X). Changes groups by the horizontal sort field.

Add (Y). Adds a vertical sort field.

X-Axis. Specifies a measure or dimension sort field. Applies to scatter charts.

Y-Axis. Specifies a measure. Applies to scatter charts.

Arrange By. Specifies the marker color. The marker color depends on the field
assigned to the color attribute. If no field is assigned to this category, then all of the
markers will be the same color. Applies to scatter charts.

Export to. Exports to Excel, Word, or PowerPoint.

Stacked. Stacks the risers on top of each other, with the length of each riser
representing the data value. Applies to column charts.

Top. Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top.
Applies to pie charts.

Trend. Draws a trendline and equation label for an individual series. Applies to
scatter charts.

Chart/Rollup Tool. Opens the Chart/Rollup Tool, which you can use to select
multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool
contains a list of columns available in the In-Document Analytics enabled report and
Group By and Measure sort fields. Drag the columns into the desired sort field.

Note: When working with the Chart/Rollup Tool for In-Document Analytics enabled
charts (specifically those with the new chart attribute syntax), the Series tab is not
supported. It is available with charts that are created with tabular reports or stand-
alone charts that do not use the new chart attribute syntax.

Restore Original. Restores the In-Document Analytics enabled report to the default
state specified in the report procedure.

Column Displays data as a column chart.
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Option Definition

Pie Displays data as a pie chart.

Line Displays data as a line chart.

Scatter Displays data as a scatter chart.

Rollup Displays the chart as a rollup table.

Advanced Chart Opens the Chart/Rollup Tool.

Original Chart Restores the In-Document Analytics enabled chart to the chart type specified in the
report procedure.

Lock/Unlock Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the
filters that you have applied in your report using the Freeze Chart or Freeze Rollup
icon. The icon indicates whether the report is linked to the filter (Freeze Chart or
Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup).

This option is available only when the chart is created from a column menu on a
tabular report.

Aggregation Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and
Distinct. The default value is Sum.
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Option Definition

Remove Filter Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area
of the chart and then clicking the Filter Chart or Exclude from Chart option from the
chart tooltip.

Usage Notes for In-Document Analytics Enabled Charts

If you are working with an AHTML chart that does not have the new chart properties
(specifically, non-bucket AHTML charts), you will encounter problems if you change the chart
type to one of the following chart types using the Advanced Chart tool at run time:

Tag Cloud

Funnel

Pyramid

Waterfall

Histogram

Radar Line

Radar Area

3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is
an AHTML bucket chart. These chart types are available under the following circumstances:

When the original chart is a non-bucket chart

When the chart is created from a tabular report

Creating a Chart with In-Document Analytics

Charts are graphical representations of data, showing trends, tendencies, and even possible
predictions. A chart often conveys meaning more clearly and effectively than data displayed in
tabular form. Charts show summaries on a higher level, giving you a better view of your most
important data.

A chart enables you to visually communicate quantitative information. Using a chart, you can
give data a shape and form, and reveal patterns and relationships among many data values. A
chart can highlight anomalies that require further investigation.
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It is important that you choose a chart that is appropriate for your data. Both InfoAssist and
App Studio provide a complete chart library of both basic and advanced charts. You can
choose from a wide variety of charts to best represent the data that you want to display.

In InfoAssist with In-Document Analytics, you can create a chart, change the type of chart, and
run the chart to take advantage of the interactive tools that are available to you.

In App Studio, you can create and edit InfoAssist charts using the Chart canvas. You use the
Chart Wizard to create a new chart and set the output format to In-Document Analytics. Once
your chart is created, you can run the chart to take advantage of the interactive, run time tools
that display.

This topic provides an overview of how to create a chart in InfoAssist and App Studio, with In-
Document Analytics enabled.

Procedure: How to Create an In-Document Analytics Chart in InfoAssist

1. In WebFOCUS Designer, click the InfoAssist tab, and then click Chart. The Open dialog box
appears.

2. From the Open dialog box, select the data source that you want to use, and click Open.
The data source that you selected appears in the Data pane of the Resources panel.

Note: The default chart type is a bar chart.

3. Drag fields onto the canvas or into the Query pane to begin building your chart. A basic
chart is shown in the following image.

4. Optionally, click the Format tab to select a different chart type from the Chart Types group.

5. On the Home tab, in the Format group, select HTML Analytic Document.

6. Save the chart and run it.

The interactive options of In-Document Analytics display, enabling you to use such features
as the Chart/Rollup tool, which lets you change the chart type as you work with your data.
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Note: In InfoAssist, the In-Document Analytics option defaults to the Legacy version of the
tool. You can use the Procedure Settings to set the In-Document Analytics option to
Designer Style, which has a different layout than the Legacy version.

Procedure: How to Create an In-Document Analytics Chart in App Studio

1. Open App Studio.

2. On the Home tab, in the Content group, click Chart.

Note: The default charting application for App Studio is InfoAssist.

3. The Chart Wizard opens, as shown in the following image.

4. Click Create Chart to create a chart using the Chart canvas.

The Chart Wizard - Choose location for the new chart window opens.

5. Navigate to where you want to create the new chart and click Next.

The Select Data Source window opens.

6. Choose an application folder in the application folder tree, and select a Master File.

You can select the Use Qualified Path check box if you want to only display the data
sources in the application folder.

7. Click Finish.

The Chart canvas opens, showing the InfoAssist interface.

8. Double-click fields in the Data Pane to add them to the chart.

Creating an In-Document Analytics Enabled Chart

88 



You can use the features and functions on the InfoAssist ribbon to format the chart.

9. To enable the In-Document Analytic format in InfoAssist:

a. Navigate to the Home tab.

b. In the Format group, select the HTML Analytic Document format.

10. To save your chart, click the Save button on the App Studio Quick Access Toolbar, or
select Save from the Application menu.

Your chart is now accessible by others in your enterprise, online or offline.

11. To run your chart, click the Run button on the App Studio Quick Access Toolbar.

The interactive options of In-Document Analytics are available, at run time.

Note: In chart mode through App Studio, the default In-Document Analytics version is the
Legacy version. When working with content in InfoAssist directly, you can switch between
the Legacy version and the Designer Style, which has similar functionality.

For more information, see the Active Technologies User’s Guide, which is available in the
WebFOCUS KnowledgeBase.

In-Document Analytics Options for Charts

Similar to the options that are available in an interactive report, you can use chart-specific In-
Document Analytics menus and options to perform your analysis.

Working With Charts Using the Chart Rollup Tool

If you are working with a chart using the Chart Rollup Tool and you subsequently create a new
chart, the new chart launches with a metadata tree, buckets, and the chart picker. This look
and feel is similar to the common interface of WebFOCUS Designer, as shown in the following
image.
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The interface loads with the fields that you had originally selected. This makes it easy to select
different fields to create different types of charts at run time.

You can drag or double-click items to add items into the buckets. In this way, you can model
different scenarios to create a chart that meets the needs of your organization. Once you have
selected the fields to include, you can select a chart type from the chart picker, which displays
on the right of the interface.

When you are done, click the checkmark, located at the top right of the interface, to apply the
specified changes to your chart and return to the original canvas.

You can test out various scenarios and review different results, all within one session.

Legacy Style Chart Options

Options for an interactive chart that used the Legacy styling are described in the following
table.

Note: For charts that employ the new attribute syntax, only the following four icons display:
More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the
Remove Filter icon displays.
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Option Definition

More Options New. Creates a new instance of the chart. This option is available only when the
chart is created from a column menu on a tabular report.

Group By (X). Changes groups by the horizontal sort field.

Add (Y). Adds a vertical sort field.

X-Axis. Specifies a measure or dimension sort field. Applies to scatter charts.

Y-Axis. Specifies a measure. Applies to scatter charts.

Arrange By. Specifies the marker color. The marker color depends on the field
assigned to the color attribute. If no field is assigned to this category, then all of the
markers will be the same color. Applies to scatter charts.

Export to. Exports to Excel, Word, or PowerPoint.

Stacked. Stacks the risers on top of each other, with the length of each riser
representing the data value. Applies to column charts.

Top. Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top.
Applies to pie charts.

Trend. Draws a trendline and equation label for an individual series. Applies to
scatter charts.

Chart/Rollup Tool. Opens the Chart/Rollup Tool, which you can use to select
multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool
contains a list of columns available in the report and Group By and Measure sort
fields. Drag the columns into the desired sort field.

Note: When working with the Chart/Rollup Tool for charts (specifically those with the
new chart attribute syntax), the Series tab is not supported. It is available with charts
that are created with tabular reports or stand-alone charts that do not use the new
chart attribute syntax.

Restore Original. Restores the report to the default state specified in the report
procedure.

Column Displays data as a column chart.
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Option Definition

Pie Displays data as a pie chart.

Line Displays data as a line chart.

Scatter Displays data as a scatter chart.

Rollup Displays the chart as a rollup table.

Advanced Chart Opens the Chart/Rollup Tool.

Original Chart Restores the chart to the chart type specified in the report procedure.

Lock/Unlock Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the
filters that you have applied in your report using the Freeze Chart or Freeze Rollup
icon. The icon indicates whether the report is linked to the filter (Freeze Chart or
Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup).

This option is available only when the chart is created from a column menu on a
tabular report.

Aggregation Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and
Distinct. The default value is Sum.
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Option Definition

Remove Filter Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area
of the chart and then clicking the Filter Chart or Exclude from Chart option from the
chart tooltip.

Creating Content Using the Chart Rollup Tool

You can access the Chart Rollup Tool from the column menu in a Designer Style interactive
chart or report enabled. There are three tabs: Chart, Rollup, and Pivot. As you create charts,
rollups, or pivot tables, each artifact displays in the analysis panel.

You can use the Chart Rollup Tool to select multiple group fields to generate the chart, rollup
or pivot table.

For the Chart tab, you can select a chart type, an aggregation, and a column for the chart, as
shown in the following image.

Procedure: How to Use the Chart Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.

3. From the Chart Rollup tool, select a chart type.

4. Optionally, add an aggregation for the currently selected dimension.

5. Select a dimension or measure from the field list.

6. Click Create.
The chart displays in the analysis panel. You can interact with the chart in the same way
as any other artifact.
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For the Rollup, you can perform an aggregation on the current report column. You can also
select a Group By value, which lists all columns in the report, as shown in the following
image.

Procedure: How to Use the Rollup Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.

3. From the Chart Rollup tool, select the Rollup tab.

4. Optionally, select an aggregation to be applied to the selected column.

5. For the Group By field, select a dimension or measure for which to perform the rollup.

6. Click Create.
The Rollup displays in the analysis panel.

For Pivot tables, you can similarly select an aggregation for the currently selected column
in the report. You can select from the existing dimensions for the Group By and Across
fields, as shown in the following image.

Procedure: How to Use the Pivot Tool

1. Create a report with multiple dimensions and measures.

2. Click on the primary dimension.
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3. From the Chart Rollup tool, select the Pivot tab.

4. Optionally, select an aggregation to be applied to the selected column.

5. For the Group By field, select a dimension by which to group the table.

6. For the Across field, select another dimension that will display as an across field.

7. Click Create.

The Pivot table displays in the analysis panel.

Creating an In-Document Analytics Enabled Dashboard

You can create an In-Document Analytics enabled dashboard by inserting multiple content
types, such as reports, charts, images, and text, into a document. An In-Document Analytics
enabled dashboard will run any report or chart using the In-Document Analytics enabled output
format, even if the report or chart itself is not in In-Document Analytics enabled output format.

You can also insert In-Document Analytics enabled dashboard prompts into a document to act
as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to
populate them based on the selections from the previous prompts.

The output format of the active dashboard must be HTML Analytic Document or PDF Analytic
Document in order to add In-Document Analytics enabled dashboard prompts.

In-Document Analytics Dashboard Prompts

The Analytic Document prompts group contains buttons that insert In-Document Analytics
enabled dashboard prompts into your dashboard. This group is only visible when the output
format of the dashboard is set to HTML Analytic Document or PDF Analytic Document. You can
access the In-Document Analytics enabled dashboard prompts on the Insert tab, in the Analytic
Document prompts group.

The following are the types of In-Document Analytics enabled dashboard prompts that you can
use to apply filters to an In-Document Analytics enabled dashboard:

Drop Down. Inserts a drop down prompt placeholder in the upper-left corner of the canvas.

List. Inserts a list prompt placeholder in the upper-left corner of the canvas.

Checkbox. Inserts a check box prompt placeholder in the upper-left corner of the canvas.

Radio Button. Inserts a radio button prompt placeholder in the upper-left corner of the
canvas.

Text. Inserts a text area prompt placeholder in the upper-left corner of the canvas.
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Note: The display of values populated in In-Document Analytics enabled dashboard prompts is
dependent on the data setting. For example, if sample data is turned on, then In-Document
Analytics enabled dashboard prompts will show sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

Target Reports

When you bind a field to an analytic document prompt, the default target report is the report
from which you dragged the field. You can add or remove target reports from an analytic
document prompt through the analytic document properties dialog box.

A report must meet one of the following requirements to be a target report:

The report must contain a field with the same name as the source field (actual field name
or AS name).

The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title
and the title is changed, the report is automatically removed as a target.

Procedure: How to Add an In-Document Analytics Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and
binding a single prompt to one of the fields of the report.

With InfoAssist in Document mode:

1. On the status bar, in the Output Types menu, accept the default output type, or click PDF
Analytic Document.

2. On the Insert tab, in the Reports group, click Report.

A placeholder appears on the canvas.

3. Drag fields onto the canvas, or into the Query pane, to create the report and start building
the dashboard.

4. On the Insert tab, in the analytic document prompts group, select a dashboard prompt to
insert into the document.

An analytic document prompt appears in the upper-left corner of the canvas. If the report is
located in the upper-left corner of the canvas, you will have to drag the prompt off the
report.
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5. Select the report and bind one of its data source fields to the prompt in one of the
following ways:

Query pane: Select the report. From the Query pane, drag the field that you want to
bind onto the prompt.

Report on the canvas: Click the report on the canvas. You can now edit it. Highlight
the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

Note: Once an analytic document prompt is added to the canvas, the document is locked
in an In-Document Analytics output format. You cannot change the HTML Analytic
Document or PDF Analytic Document format if there are prompts present on the canvas.
To switch to a non-active output format, you must remove all prompts.

Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an In-Document Analytics enabled dashboard. Each
report can have multiple prompts associated with it.

Procedure: How to Build a Dashboard With Multiple Reports as Targets and Sources

The following procedure describes how to set up analytic document prompts for two reports on
a dashboard. In the example that is used, the first report contains information about the
categories of electronics products sold in various regions. The Product,Category field will be
bound to a group of radio buttons. Each radio button will represent a particular product
category of electronics. When you select a radio button for a product category, for example,
Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of
electronics consumers. The Gender field will be bound to a drop-down list. The list will display
the values, F (female) and M (male). When you select a gender from the drop-down list, the
report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.

2. Create an In-Document Analytics enabled dashboard by adding two reports with the
following components, respectively:

Report 1:

Product,Category

Store,Business,Region

Discount
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Gross Profit

Report 2:

Gender

Customer,Continent

Product,Category

3. On the Insert tab, in the analytic document prompts group, add the following active
dashboard prompts to the dashboard, positioning them relative to each respective report.

Radio Button: This prompt will be used for Report1.

Drop Down: This prompt will be used for Report2.

For more information on working with analytic document dashboard prompts, see How to
Add an In-Document Analytics Dashboard Prompt to a Dashboard on page 96.

4. Right-click the radio button analytic document dashboard prompt for which you want to
bind a field to and click Properties.

The analytic document properties dialog box opens.

The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2)
that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you
want to bind an analytic document prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for
the region report (Report 1), as shown in the following image.
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The next step describes how to bind the Product,Category field from the region report to
the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the analytic
document prompt.

In this example, the Product,Category field has been selected for the radio button list
(radiobutton_1), as shown in the following image.

Note: You can optionally specify an ascending or descending sort order for the current
scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
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In the following image, the radio button list is bound to the Product,Category field. It
displays all product categories by which you can filter the report.

The following steps describe how to bind the Gender field in the gender report (Report2) to
the drop-down list prompt.

8. Right-click the Drop Down analytic document prompt for which you want to bind a field and
click Properties.

The analytic document properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the
Prompts list.
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9. From the Report drop-down menu, select the report (Report2) that contains the field to
which you want to bind an analytic document prompt.

The next step describes how to bind the Gender field from the gender report to the drop-
down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the
analytic document prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets
list and Report1 (region report) appears in the Candidate Reports list.

Note: To move a report from the Candidate Reports list box to the Targets list box, select
it and click the Add to List arrow. To remove a report from the Targets list box, select it
and click the Remove from List arrow. You can select multiple reports by holding down the
Ctrl key and clicking each one.

11. Click OK.

The prompt is now bound to the Gender field on the dashboard. You can now filter the
gender report by female or male, as shown in the following image.
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The final dashboard displays, as shown in the following image.

Procedure: How to Change the Field

You can change the field to which the analytic document prompt is bound.

1. Create an In-Document Analytics enabled dashboard in Document mode, or open an
existing dashboard, and bind an analytic document prompt to a field.

2. Right-click theanalytic document prompt that you want to configure, and click Properties.

The analytic document prompt properties dialog box opens.

3. From the Field menu, select a different field.

A warning message alerts you that changing the source field for the prompt will remove the
existing prompt and any dependent (child) prompts from the cascades.

4. Click OK to close the warning.

5. Click OK to close the analytic document prompt properties dialog box.

The analytic document prompt is updated with the new source field.
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Procedure: How to Change the Filter Condition

1. Create an In-Document enabled dashboard in Document mode, or open an existing
dashboard, and bind an analytic document prompt to a field, as described in How to Add
an In-Document Analytics Dashboard Prompt to a Dashboard on page 96.

2. Right-click the analytic document prompt that you want to work with, and from the shortcut
menu, select Properties.

The analytic document prompt properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the analytic document
prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater
than, and Greater than or equal to.

4. Click OK.

The filter condition is applied to the analytic document prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1. Create an In-Document Analytics dashboard in Document mode, or open an existing
dashboard containing at least one report, and add at least two analytic document
prompts, as described in How to Add an In-Document Analytics Dashboard Prompt to a
Dashboard on page 96.

2. Bind the fields to prompts that you have added, as described in How to Add an In-
Document Analytics Dashboard Prompt to a Dashboard on page 96.

Procedure: How to Cascade Prompts

When you have more than one prompt on the canvas, you can cascade prompts to populate
them based on the selections of the previous prompts. Cascading prompts have a parent-child
relationship, in which the parent filters the available options of the child.

An analytic document prompt can be the parent of more than one other prompt, but cannot be
a child of more than one prompt.

1. Create an In-Document analytics dashboard in Document mode, or open an existing
dashboard, and bind at least two analytic document prompts to fields.

2. Right-click the analytic document prompt that you want to configure, and click Properties.

The analytic document properties dialog box opens.

3. Click Cascades.
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By default, a cascade named Cascade1 appears in the Cascades section of the analytic
document prompt properties dialog box.

You can click the Create a new cascade  button to create a new cascade.

You can click the Delete selected cascade  button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

Note: You can remove prompts from the Selected Prompts list box by selecting them and
clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and
6.

By default, the hierarchy of the prompts is determined by the order in which they are
added to the Selected Prompts list. The cascade of the prompts is from top to bottom.
The prompts that come first in the Selected Prompts list are the parents of the lower
prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt
list box and clicking the Move Up and Move Down arrows.

9. Click OK.

The cascade is created.

10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the
one that filters the report.
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Chapter3 In-Document Analytics for Mobile Web
Apps

This topic describes In-Document Analytics features and functions available on mobile
and gesture-enabled devices with multi-touch capability, such as the Apple® iPhone® and
Apple iPad®.

In this chapter:

Requirements for Mobile Web Apps

Mobile Web Apps Features

Standard Gesture Support

Running an In-Document Analytics Report on a Mobile Device

Running an In-Document Analytics Dashboard on a Mobile Device

Requirements for Mobile Web Apps

Apple requires that any web content that is accessed from an iPhone app is compatible with,
and optimized for display on, all Apple iOS-based devices. Active Technologies comply with web
standards and are compatible with the Apple Safari browser.

For additional information, see Web Browser Support for WebFOCUS, which can be accessed by
clicking on the following URL:

https://techsupport.informationbuilders.com/tech/wbf/wbf_tmo_027.html

Note: Some browsers may function differently depending on the operating system. See the
WebFOCUS Release Notes for detailed information on known issues related to browser version
or configuration.

Mobile and Tablet Device Support Information

The following apply to In-Document Analytics for mobile web apps.

In-Document Analyticsfor Adobe Flash Player and for PDF are not supported on devices that
do not support Adobe® Flash® Player. Only In-Document Analytics HTML JavaScript charts
are available on such devices.

Running an AHTML report with more than 30,000 records may cause the mobile Safari
browser to close on the Apple iPad. To handle a large set of data when using Safari on
iPad, turn on the active cache feature.
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If you are viewing interactive content on a smartphone where the size of the screen of the
measures 400 pixels, your content will always display in Full screen mode even when you
switch between portrait or landscape views, to maximize your view of the output.

Mobile Web Apps Features

The following features apply to In-Document Analytics implemented on mobile devices.

In-Document Analytics checks for the screen size of the device at run time. If the height of
the screen is less than 500 pixels, In-Document Analytics assume that the report or
dashboard is running on a mobile device and the mobile user interface is used. This
feature applies when the device is in either portrait or landscape mode.

By default, In-Document Analytics use tab window navigation, familiar to most users. In tab
window navigation, open windows are represented by tabs across the top of a report. Tap a
tab to navigate between windows.

Important:

In full-screen web app view, Rollup and Pivot tables created from Rollup menu options are
not displayed. You can view them when you switch to the original interactive report view.

In full-screen web app view, the totals in a Pivot table may appear misaligned when
switching BY and ACROSS columns in the Pivot table.

Standard Gesture Support

In-Document Analytics support the following standard interactive gestures that are used on a
multi-touch screen. 

Gesture Description

Tap To press or select a control or item (analogous to a single mouse click).

Drag To move columns left and right or up and down slowly when an active
report is in a grid in full-screen web app view.

Flick To move columns left and right or up and down quickly when an active
report is in a grid in full-screen web app view.
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Gesture Description

Swipe To page forward or backward in a pagination bar when an active report is
in a grid in full-screen web app view.

Double tap To zoom in and center a block of content or an image. If you are already
zoomed in, a double tap zooms out.

You can also double tap the screen to hide both the top and bottom
toolbars, as well as the pagination bar. Double tap the screen again to
show both toolbars and the pagination bar.

The following table lists and describes gestures specific to mobile charts.

Gesture Description

Tap The tap gesture is used to select or highlight an item, such as a riser,
and show its tooltip (analogous to pausing the mouse over an object).

Long touch Touching and holding an item, such as a riser, is used to trigger a drop-
down menu on events that support it (analogous to a single mouse
click).

Short drag Can be used interchangeably with long drag for either scrolling (on
charts with scroll bars or moving around on maps) or for marquee data
selection.

On charts that include both scrolling and marquee selections, a short
drag will scroll and a long drag will do a marquee data selection.

Long drag Can be used interchangeably with short drag for either scrolling (on
charts with scroll bars or moving around on maps) or for marquee data
selections.

Note that if a chart supports only scrolling or only marquee selections,
then a long drag does nothing.

On charts that include both scrolling and marquee selections, a short
drag will scroll and a long drag will do a marquee data selection.
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The following image shows a tooltip that appears when you tap on a riser in the Legacy version
of In-Document Analytics (for example, the pie slice with the largest data value).

The following image shows the options available for a marquee data selection in the Legacy
version of In-Document Analytics, also known as lassoing (for example, when a long drag is
performed over the two pie slices with the largest data values).
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Running an In-Document Analytics Report on a Mobile Device

The following image shows a sample interactive report that is running on an iPad in full-screen
web app view using the Legacy style.
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The following image shows a sample interactive report that is running on an iPad in full-screen
web app view using the Designer style.

You can use the icons on the pagination bar of the grid in an interactive report to:

Adjust the viewing mode, which can be either full-screen web app view or original interactive
report view.

Position the pagination bar at the top or bottom of the report.

By tapping the column title of a report, you can access the report column drop-down menu to
refine the data in different ways and manipulate the way that you present it.

You can also use the icons on the chart, rollup, or pivot tool bar of an interactive report to
adjust the viewing mode, which can be either full-screen web app view or original active report
view.

Running an In-Document Analytics Report on a Mobile Device
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Adjusting the Views

In the Legacy style, tap the Fullscreen View  icon to display the report in full-screen web

app view mode. In Designer mode, tap the Fullscreen View icon to display the report in full-
screen web app view mode. Full-screen web app view means that the report is presented as a
gesture-enabled web app with the features and functionalities customized for mobile and
touch-screen devices. This is the default view for the display of a report on mobile and multi-
touch devices.

In full-screen web app view, tap the Original View  icon to restore the report to its original
interactive report view. Original interactive report view means that the report is presented as a
regular active report running inside the browser. All the functionalities of interactive reports in
the desktop browser are intact in this mode, except the window display option, which is set to
Tabs instead of Cascade by default to accommodate devices with small screen sizes.

In the Designer style, you can exit fullscreen or restore original using the options shown on the
hamburger menu, as shown in the following image.

Adding an In-Document Analytics Report or Dashboard to the Home Screen

For easy access, you can add an interactive report or dashboard to the Home screen of your
device. When an interactive report or dashboard is added to the Home screen, it will create an
icon of the report or dashboard. The user can tap the icon to access the interactive report or
dashboard instead of entering its URL in the device browser. When the interactive report or the
dashboard is opened from the Home screen, it will connect to WebFOCUS to retrieve the most
up-to-date information. Accessing interactive reports and dashboards from the icon provides
more space to view reports or dashboards on devices with small screen sizes. There will be no
browser toolbars to take up screen space.
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To add an interactive report or dashboard to the Home screen on the iPhone and iPad, open an
interactive report or dashboard in the browser and then tap the Action icon at the bottom of the
screen. Tap the Add to Home Screen option.

To add an interactive report or dashboard to the Home screen on Android devices, open an
interactive report or dashboard in the browser and open the menu options. Tap Add shortcut to
Home. Depending on your device, you may need to tap Add bookmark first. In this case, go to
the Bookmarks list and touch and hold the bookmark you just added to bring up the Add
shortcut to Home option.

Hiding and Showing the Pagination Bar and the Top and Bottom Toolbars

In full-screen web app view, you can hide the pagination bar and the top and bottom toolbars
of the grid and chart. This is done so that there is more space to view the interactive reports
and charts on devices with small screen sizes.

To do this:

1. Click the Fullscreen View icon to display the report in full-screen web app view, if it is not
already in that view.

2. In the grid cell data area or in a chart, double tap to hide the pagination bar and the top
and bottom toolbars.

3. In the grid cell data area or in a chart, double tap to show the pagination bar and the top
and bottom toolbars.

Navigating Between Pages

To navigate between the pages of an interactive report:

1. Click the Fullscreen View icon to display the report in full-screen web app view if it is not
already in that view.

2. On the pagination bar, swipe from right to left to display the next page of the report.

3. On the pagination bar, swipe from left to right to display the previous page of the report.
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Accessing the Report Column Drop-Down Menu

The following image shows a sample report column drop-down menu for a numeric data column
in full-screen web app view in the Legacy style.

The menu option Visualize is available only for numeric data. The menu options Show Columns
and Show All are available only when there are hidden columns in the report. The menu
options Freeze Column and Unfreeze All are available only in full-screen web app view.
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The following image shows the Column menu, which is available in the Designer style. It offers
comparable functionality to that which is offered in the Legacy style.

Procedure: How to Access the Report Column Drop-Down Menu in the Legacy Style

1. On a run-time tabular report (grid), tap once on a column title.

The report column drop-down menu is displayed, with a selection of options.

2. Tap the desired menu option. An arrow to the right of a menu option means that there is
an additional menu associated with that option. The options and their associated menus
are described in the topics that follow.

3. To remove the report column drop-down menu, tap Cancel.

Procedure: How to Access the Report Column Drop-Down Menu in the Designer Style

1. On a run-time tabular report (grid), tap once on a column title.

The Column menu is displayed, with a selection of options.

2. Tap the desired option (for example, Chart, Rollup or Pivot).

3. Optionally, add filters or highlight rows in your report.
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4. To remove the options that you have specified through the Column menu, tap the filter
icon at the top of the column.

Sorting Data

You can sort data in any column of an interactive report in ascending or descending order.

From the report column drop-down menu in the Legacy version, tap Sort Ascending to sort the
data in ascending order. In Designer style, click Ascending in the sort options section of the
Column menu.

From the report column drop-down menu in the Legacy version, tap Sort Descending to sort the
data in descending order. In Designer style, click Descending in the sort options section of the
Column menu.

Filtering Data

On a run-time interactive report, locate and tap the title of the column that you wish to filter.
From the report column drop-down menu in the Legacy version, tap Filter or touch the right
arrow for the Filter menu option. The Filter menu is displayed, specifying the default filter
condition and default values for the selected column in the existing report. In the Designer
style, locate and tap the title of the column that you wish to filter. From the Column menu, tap
Filter to specify filtering criteria.

The following image shows a sample Filter menu in the Legacy version. In this example, the
default condition is Equals and the default value is Alabama. Alabama is the first value in the
existing report for the selected column.

The menu retains any previous filters that were applied to this column of the report.
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In the Legacy version, you can:

Tap Done once to see the result of the default condition and values. The filtered report is
automatically generated, and a new Filter tab is appended after the Report tab and any
other existing tabs. On the new Filter tab, you can change the default condition and values
to customize the filter for your reporting needs.

You can also tap the Condition and Values drop-down dialog box to change the filter
condition or values before tapping the Done button.

Tap Clear All to remove all the filters that are currently applied to this report.

The Designer Style filter applies the changes dynamically as selections are made, as shown in
the following image.
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Using the Filter Tab

The following image shows a sample Filter tab for an interactive report (grid) in the Legacy
style.

The Filter tab shows all the filters that are applied to the report.

An individual filter applies only to the specific report from which the filter was created or to
which the filter was added. You can scroll up and down the list to view all the individual filters.

From the Filter tab, you can do the following.

Tap a drop-down list to change the filter condition or values. An asterisk next to a value (for
example, next to Alabama in the preceding example) means that multiple values define the
condition.

Tap the Delete icon to remove an individual filter from the report.

Tap Operator: AND to change the condition (operator) between all existing filters from AND
(the default) to OR.

Tap Add Condition to define a new filter.

Tap Filter to apply a modified or new filter and generate the new report.

Tap Highlight to apply highlight to the filtered values in the report.

Tap Clear All to remove all the filters that are currently applied to the report.

Calculating Data

From the report column drop-down menu in the Legacy version, tap Calculate or touch the right
arrow for the Calculate menu option to display a menu from which you can apply a calculation
to the selected column.
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The following image shows the Calculate menu for a numeric data column. The calculations
that are available on the menu depend on the data type of the selected column: numeric,
alphanumeric, or date.

Note that the options for the Designer style are similar.

In the Legacy version, you can do the following:

Tap a calculation type in the list. A new report is generated on the Report tab. The
calculated result for the selected column is displayed at the location in the grid specified in
the WebFOCUS report procedure. Depending on the size of the screen that you are using,
the calculated result may be displayed over two lines.

From the report column drop-down menu, tap Calculate and then tap Clear to remove the
calculation that was last applied to the report.

From the report column drop-down menu, tap Calculate and then tap Clear All to remove all
the calculations that are currently applied to the report.
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Viewing Data as a Chart

When you run an interactive report on an iPad, you can tap Chart from the report column drop-
down menu and tap the right arrow, or touch the right arrow for the Chart menu option to
display a menu that specifies the default value for the type of chart that will be displayed and
the default aggregation (calculation) that will be used to draw the chart. Also listed are the
columns that are available for display on the X-axis of the chart (the Group By columns). 

The following image shows a sample Chart menu. In this example, the default chart type is Bar
and the default aggregation is Sum, for the selected numeric data column. Columns that can
be displayed on the X-axis (Group By columns) are listed on the menu.

You can access the same menu from the Advanced Chart icon at the bottom of the screen if
you are already in a chart in full-screen web app view. This menu and icon apply to the
WebFOCUS HTML5 chart engine (ARGRAPHENGINE=JSCHART).
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Similar options are available in the Designer style, which display when you tap a column
heading, as shown in the following image.

Tap a Group By column for the X-axis to automatically generate a chart that is the result of the
default values and the selected X-axis column. The chart is displayed in tab view, with a new
Chart tab appended after the Report tab and any other existing tabs.

The chart is generated in full-screen web app view by default, if you are in that view.

Alternatively, you can tap the Chart Type menu to change the chart type or tap the Aggregation
drop-down menu to change the calculation type, before selecting the Group By column to
generate the new chart.
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Tapping the Chart Type menu displays the Chart Type options, as shown in the following
image.
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In the Designer style, you can select a chart type from the column menu, as shown in the
following image.
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In the Legacy format, once you have selected a chart type category, such as Pie, and then tap
the Donut chart type that will be used to display the chart. The following image shows some of
the charts in the Pie category.

If you are using the WebFOCUS Mobile Faves for iOS app, it may take a moment for the chart
types in a chart category to be displayed. There is no JavaScript engine that renders JavaScript
faster inside the iOS app, and JavaScript cannot take advantage of features such as hardware
acceleration.

On the new Chart tab, you can change the values to customize the chart for your reporting
needs. You can also manipulate the way that you present the data.
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Using the In-Document Analytics Chart Menu

In the Legacy version, the interactive chart menu and its submenus allow you to change the
columns used in the chart or rollup table or select multiple columns from those available in the
report, including hidden and NOPRINT columns.

The following image shows the interactive chart menu.
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Similar options are available for the Designer style, including Rollups and Pivoting that support
Group By and Across fields, as shown in the following image.

In the Legacy version, you can:

Tap New to create a copy of the same chart on a new Chart tab.

Tap Original View or Fullscreen to display the chart in the desired viewing mode.

Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add
any column available in the report, including hidden and NOPRINT columns. On the Group
By (X) submenu, values used in the existing chart are displayed at the top of the column
names and are selected (checked) by default. A newly selected X-axis column is displayed
at the top of the column names and is checked.
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For a bar chart, tap Stacked to create a stacked AHTML bar chart.

The following image shows a sample Group By (X) submenu. The column Product Type is used
as the X-axis in the existing chart.

Tap once to select an additional column, or tap again to deselect the column. Once you select
or deselect a column, the Chart tab displays the modified chart, reflecting all the changes.

Tap Add (Y) to change the column selected for the Y-axis or add any column available in the
report, including hidden and NOPRINT columns. On the Add (Y) submenu, the values used
in the existing chart are selected by default.
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The following image shows a sample Add (Y) submenu. The column Cost of Goods is used
as the Y-axis in the existing chart.

Tap once to select an additional column, or tap again to deselect the column. Once you
select or deselect a column, the Chart tab displays the modified chart, reflecting all the
changes.

Viewing Data in a Rollup Table

Tap Rollup or touch the right arrow for the Rollup menu option to display a menu that specifies
the default aggregation (calculation) that will be used to generate the rollup table. Also listed
are the Group By columns that are available for display in the rollup table.
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The following image shows a sample Rollup menu. In this example, the default aggregation is
Sum for a numeric data column. The available Group By columns are listed on the menu.
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Similar options are available for the Rollup menu in the Designer style, as shown in the
following image.

Tap a Group By column to automatically generate a rollup table that is the result of the default
aggregation value and the selected column. For the Designer type, click Create to create the
rollup. You must select at least one Group By column. After you select a column, the rollup
table is displayed in tab view, with a new Rollup tab appended after the Report tab and any
other existing tabs.

The rollup table is generated in full-screen web app view by default, if you are in that view.

You can also tap the Aggregation drop-down menu to change the calculation type before
selecting the Group By field to generate the new rollup.

On the new Rollup tab, you can change the values to customize the rollup table for your
reporting needs, making it more complex as required for analysis. You can also manipulate the
way that you present the data.
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Using the Rollup Tab

The following image shows a sample Rollup tab.
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In the Designer style, when you create a Rollup, a separate artifact is placed in the Analysis
panel, as shown in the following image.

In the Legacy style, beneath the rollup table is the chart or rollup tool bar, which contains the
icons described in the following table.

Icon Name Description

More Options Displays the interactive chart or rollup menu. For
details, see Using the Rollup Menu on page 133.

Column Changes the report to a column chart.

Pie Changes the report to a pie chart.

Line Changes the report to a line chart.
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Icon Name Description

Scatter Changes the chart type to scatter.

Scatter charts are available for numeric columns.

Rollup Displays the chart as a rollup table.

Advanced Chart Opens the chart tool to change the chart type.

Original Chart Restores the current chart type to the initial chart type
that was displayed.

Lock/Unlock Freezes the chart or rollup table. You can link or unlink
a chart or rollup table to the filters that you have
applied in your report using the Freeze Chart or Freeze
Rollup icon. The icon indicates whether the report is
linked to the filter (Freeze Chart or Freeze Rollup) or not
(Unfreeze Chart or Unfreeze Rollup).

Aggregation Changes the aggregation method.
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Using the Rollup Menu

The rollup menu and its submenus allow you to select multiple columns from those available in
the report, including hidden and NOPRINT columns.

The following image shows the rollup menu.
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In the Designer style, the Rollup menu displays as part of the Column menu, as shown in the
following image.

To access the Rollup menu in the Legacy style, tap the More Options  icon with a rollup
table open.

In the Legacy version, you can:

Tap New to create a copy of the same rollup table on a new Rollup tab.

Tap Original View or Fullscreen to display the rollup table in the desired viewing mode.

Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add
any column available in the report, including hidden and NOPRINT columns. On the Group
By (X) submenu, the Group By column used in the existing rollup table is displayed at the
top of the column names and is selected (checked) by default.
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The following image shows a sample Group By (X) submenu. The column Product Type is
the Group By column for the existing rollup table.
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In the Designer style, the Group by Values display when you click on the Group By field, as
shown in the following image.

In the Legacy style, tap once to select an additional column, or tap again to deselect the
column. In the Designer style, click Create to create the Rollup. Once you select or deselect
a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

Tap Add (Y) to change the column selected for the Y-axis or add any column available in the
report, including hidden and NOPRINT columns. On the Add (Y) submenu, the Y-axis column
used in the existing report is selected by default.
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The following image shows a sample Add (Y) submenu. The column Cost of Goods is the Y-
axis column for the existing report.
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In the Designer Style, you can similarly add a Y-axis column for the current report.

In the Legacy Style, tap once to select an additional column, or tap again to deselect the
column. In the Designer style, click Create to create the Rollup. Once you select or deselect
a column, the Rollup tab displays the modified rollup table, reflecting all the changes.

Viewing Data in a Pivot Table

Tap Pivot (Cross Tab) or touch the right arrow for the Pivot (Cross Tab) menu option to display a
menu that specifies default values for the aggregation (calculation) that will be used to
generate the pivot table, the column that will be displayed across the pivot table, and the
Group By column that will be used to generate the table.
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The following image shows a sample Pivot Tool menu in the Legacy style. In this example, the
aggregation is Sum (default for a numeric column), the Across column is Product Type, and the
Group By column is Region. A pivot table requires at least one across column and one Group
By column. The first value for the column in the report is displayed by default.
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In the Designer style, the aggregation is also Sum, the Group By column is Product Category,
and the Across column is Product Subcategory, as shown in the following image.

In the Legacy style, tap Done once to see the result of the default values. In the Designer
style, click Create to create the pivot table. The pivot table is automatically generated in tab
view, and a new Pivot tab is appended after the Report tab and any other existing tabs.

The pivot table is generated in full-screen web app view by default, if you are already in that
view.

On the new Pivot tab, you can change the default values to customize the pivot table for your
reporting needs, making it more complex as required for analysis.
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Using the Pivot Tab

The following image shows a sample Pivot table in Legacy style.

The following image shows a sample Pivot table in Designer style.

Beneath the pivot table in Legacy style is the active pivot tool bar, which contains the icons
described in the following table.
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Icon Description

Displays the active pivot menu. For details, see Using the Pivot Menu on page
142.

Freezes the pivot table. You can link or unlink a pivot table to the filters that
you have applied in your report using the Freeze Pivot icon. The icon indicates
whether the report is linked to the filter (Freeze Pivot) or not (Unfreeze Pivot).

Changes the aggregation method.

Using the Pivot Menu

In the Legacy style, the pivot menu and its submenus allow you to select multiple columns
from those available in the report, including hidden and NOPRINT columns.

The following image shows the pivot menu.
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In the Designer style, the options are similar, as shown in the following imagee.

In the Legacy version, you can:

Tap New to create a copy of the same pivot table on a new Pivot tab.

Tap Group By (X) to change the column selected for the X-axis (the Group By field) or add
any column available in the report, including hidden and NOPRINT columns. On the Group
By (X) submenu, the Group By and Across columns used in the existing pivot table are
displayed at the top of the column names and are selected (checked) by default. You can
switch Group By and Across columns using the arrow icons in the pivot table at run time.
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The following image shows a sample Group By (X) submenu. The Product Type column is
used for the Across column and the Region column is used for the Group By column in the
existing pivot table.

Tap once to select an additional column, or tap again to deselect the column. Once you
select or deselect a column, the Pivot tab displays the modified pivot table, reflecting all
the changes.

Tap Add (Y) to change the column selected for the measure field to any column available in
the report, including hidden and NOPRINT columns. On the Add (Y) submenu, the measure
column used in the existing report is selected by default.
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The following image shows a sample Add (Y) submenu. The column Cost of Goods is the
measure field for the existing report.

Tap once to select a column, or tap again to deselect the column. Once you select or
deselect a column, the Pivot tab displays the modified pivot table, reflecting all the
changes.

Using Data Visualization

Tap Visualize to add or remove visualization bars to the selected column. The Visualize option
is available for numeric data columns.

Hiding or Restoring a Column

Tap Hide Column to suppress the display of the selected column in the report.

Tap Show All to restore all the hidden columns to the report.

Tap Show Columns to list the names of the columns that are hidden in the report, allowing you
to individually restore a column.

Tap the name of a specific column in the hidden columns list to restore that column to the
report.

The Show All and Show Columns options are available only when there are hidden columns in
the report.
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Freezing or Unfreezing a Column

Tap Freeze Column to freeze the selected column and all the columns to the left of it. You
cannot scroll left or right within the frozen part of the report, but you can scroll up and down
within the frozen part. You can scroll in any direction in the unfrozen part of the report.

Tap Unfreeze All to unfreeze all the frozen columns in the report.

Note: This functionality is currently not supported in the Designer style of In-Document
Analytics.

In full-screen Web app view, the column titles and report headings will stay fixed as you scroll
through the report when the Freeze Column option is turned on.

Controlling the Number of Records Per Page

In the Legacy style, tap Show Records or touch the right arrow for the Show Records menu
option to list the groups of records available for display per page in the report. On the Show
Records menu, you can:

Tap a group of records (for example, 20 Records) to display, per page, only the number of
records in that group.

Tap Default to display the number of records (lines) per page that is specified in the
WebFOCUS report procedure.
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Tap Show All to display all the records in a single page.

In the Designer style, you can use the navigational arrows along the bottom of the interface to
navigate groups of data.

Restoring a Report to Its Original State

In the Legacy version, tap Restore Original to restore the interactive report to its default state
specified in the WebFOCUS report procedure. In the Designer version, tap the hamburger menu
and tap Restore Dashboard.

Unsupported Menu Options

The following menu options are not supported by In-Document Analytics for mobile web apps.

Comments

Send as E-mail
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Save Changes

Grid Tool

Chart/Rollup Tool

Pivot Tool

Export and Export to for a chart

Print

Window

Accordion

Note: Active cell menu options are not supported (for example, Comments, Highlight Value,
Highlight Row, Unhighlight All, and Filter Cell).
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Running an In-Document Analytics Dashboard on a Mobile Device

Note: Adaptive Dashboard is only available in the Legacy version of In-Document Analytics.
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The following image shows a sample interactive dashboard that is running on an iPad, with
Adaptive Dashboard disabled (this is the default).

The dashboard bar at the top of an interactivedashboard contains the page layout tabs. On
mobile devices, the bar is floating instead of fixed, making the available functions always
accessible, no matter where you move within the dashboard.

You can use standard gestures on an interactive dashboard to scroll left and right or up and
down, or zoom in and zoom out.

You can tap the Fullscreen View icon  on the right edge of the pagination bar for an
individual grid or on the right edge of a chart tool bar or pivot tool bar to view the grid, chart,
rollup table, or pivot table on the dashboard in full-screen mode.
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Chapter4 Designing Your Applications With
WebFOCUS Syntax

This topic describes how to implement design features that enhance your applications
using WebFOCUS syntax.

The reports, charts, and dashboards described in this topic are enabled to use the full
capabilities of In-Document Analytics. They are called In-Document Analytics reports or
interactive reports, In-Document Analytics charts or interactive charts, and In-Document
Analytics dashboards or interactive dashboards.

For more information about how to create, style, and analyze reports and charts with the
WebFOCUS language, see the Creating Reports With WebFOCUS Language manual.

In this chapter:

Controlling the In-Document Analytics Cache

Suppressing the Display of the Filter Options in a Tooltip

Styling the Filter Selection Dialog Box

Implementing Cascading Multi Drill

Customizing the Page Range on the Pagination Bar

Controlling the File Compression of Interactive Reports

Controlling the In-Document Analytics Cache

Because all post-retrieval processing is performed in the memory of the web browser, an
interactive report has a processing limit of approximately 5,000 records or 100 pages of
output. The cache option enables you to send only the first page of report output to the
browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting
Server. The server also becomes the resource for performing all calculations, sorting, and
filtering when cache is enabled. Since cache uses on-demand paging functionality, WebFOCUS
Viewer is not supported.

You can enable cache and set its mode and format, using the SET commands described in this
topic. For details on the ways that you can issue a SET command, see the Developing
Reporting Applications manual.
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Syntax: How to Enable the In-Document Analytics Cache for Active Technologies Reports

The syntax is

SET WEBVIEWER = {ON|OFF}

SET CACHELINES = {n|100}

where:

ON

Runs the report with cache enabled.

OFF

Does not enable cache when the report is run. OFF is the default value.

n|100

Specifies the number of rows retrieved from cache. The default value is 100.

Tip: It is recommended that you set the number of rows retrieved five times greater than
the number of lines retrieved per page (as indicated in SET LINES). The minimum number
of rows retrieved is 100. Setting LINES greater than 200 with the AHTML output format
produces a report with no output. If editing the SET LINES syntax for a procedure with
AHTML, it is recommended that you code SET LINES equal to or less than 200 since the
Internet Explorer JavaScript engine is slower than any other browser (such as Firefox,
Opera, Google Chrome, and so on).

You can also issue the SET WEBVIEWER and SET CACHELINES commands within a request
using:

ON TABLE SET WEBVIEWER {ON|OFF}

ON TABLE SET CACHELINES {n|100}

Syntax: How to Set the Mode of the In-Document Analytics Cache

The SET ARCACHEMODE command determines which HOLD files are created on the
WebFOCUS Reporting Server for use with cache. For details on HOLD files, see the Creating
Reports With WebFOCUS Language manual.

The syntax is

SET ARCACHEMODE = {HOLD|NOHOLD|NOEXTRACT}
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where:

HOLD

When combined with ARCACHEFMT=BINARY, this setting results in the original behavior of
cache. HOLD files for all requests are created on the WebFOCUS Reporting Server. This is
the default value.

NOHOLD

Suppresses the creation of HOLD files for Rollup tables and charts.

NOEXTRACT

Suppresses the creation of all HOLD files, including the initial extract. Use this setting
when the target database table is pre-built and does not change often.

You can also issue the SET ARCACHEMODE command within a request using:

ON TABLE SET ARCACHEMODE {HOLD|NOHOLD|NOEXTRACT}

Syntax: How to Set the Format of the In-Document Analytics Cache

The SET ARCACHEFMT command determines the format in which data is stored in a HOLD file.

The syntax is

SET ARCACHEFMT = any_valid_database_format

where:

any_valid_database_format

Is an output file format supported by WebFOCUS, for example, BINARY or FOCUS.

BINARY format saves report data and stores numeric fields as binary numbers. When
created as a HOLD file, BINARY also generates a Master File. BINARY is the default
value for HOLD files.

FOCUS format creates a proprietary FOCUS data source. Four files result: a HOLD data
file, a HOLD Master File, and two work files.

For more information on additional output file formats, see the Creating Reports With
WebFOCUS Language manual.

You can also issue the ARCACHEFMT command within a request using:

 ON TABLE SET ARCACHEFMT any_valid_database_format
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Reference: Usage Notes for the In-Document Analytics Cache

The following apply when cache is enabled:

The Restore Original menu option is not supported for an interactive report that contains
data visualization bars.

The Export menu option does not export a calculation applied to a tabular report.

Comments for an accordion report are cleared if you sort output with the Sort Ascending or
Sort Descending command.

Suppressing the Display of the Filter Options in a Tooltip

By default, when a user clicks a riser on an interactive chart, two filter options are displayed in
the tooltip that appears. They are Filter Chart and Exclude from Chart. Using WebFOCUS
StyleSheet code, you can suppress the display of the filter options. When the user clicks a
riser on the chart, the options are not available, and filtering through the tooltip is disabled.

Note:

This feature is available for an interactive chart with output format AHTML.

This feature is not available in the GUI.

Syntax: How to Suppress the Display of the Filter Options in a Tooltip

The syntax is

TYPE=REPORT, ALLOW-FILTER={ON|OFF},$

where:

ON

Displays the filter options in a tooltip when a user clicks a riser on the chart. This is the
default value.

OFF

Suppresses the display of the filter options in a tooltip when a user clicks a riser on the
chart. For example, the StyleSheet code is:

ON TABLE SET STYLE *
TYPE=REPORT,
   ALLOW-FILTER=OFF,
$
ENDSTYLE
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Styling the Filter Selection Dialog Box

A default set of styles for the elements of an interactive report is supplied with In-Document
Analytics in a JavaScript Object Notation (JSON) file named irpcfg.json. This file resides on the
WebFOCUS Reporting Server. You can overwrite the default styles and apply your own custom
styles to the elements of an interactive report, directly, within the individual report procedure.
In the procedure, you include your custom styles in a TABLE_JS block of code with cascading
style sheet (CSS) class selectors, as described in this topic. The custom styles will be applied
to the report elements at run time.

This feature eliminates the need for the creation and management of multiple customized
files. If you have already made customizations using the files available with your software, the
customizations specified in the TABLE_JS code will overwrite them.

The TABLE_JS block of code described in this topic is an extension of the WebFOCUS reporting
language. It is written in the JavaScript Object Notation (JSON) data-interchange format.

The CSS class selectors described in this topic use the standard HTML CSS class attributes.

The Filter Selection dialog box is displayed on an interactive report at run time when the user
selects Filter from a drop-down column menu on the report. This topic describes specifically
how to style the Filter Selection dialog box. However, you can apply the same technique to
other In-Document Analytics classes, such as .activeReport class.

Note:

This feature is available for an interactive report with output format AHTML.

This feature is not available in the GUI.

Syntax: How to Style the Filter Selection Dialog Box

*TABLE_JS
 "styles": {
“html”:
{ ".arFilterButton":[ "property:value;",…] }
}
 
*END

where:

.arFilterButton

Is an In-Document Analytics class that defines the overall look of the buttons on the Filter
Selection dialog box. There is no equivalent option in a WebFOCUS StyleSheet to overwrite
this class.
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property.value

Is a CSS property:value pair that you supply to define a customized style.

Example: Styling the Filter Selection Dialog Box

The following interactive report procedure uses TABLE_JS code and CSS class selectors to
style the Filter Selection dialog box.

The CSS properties as used in the sample procedure are described in the following table.

CSS Property Description

font-family Name of a font family that is applied to an
element (for example, verdana).

padding-top Top padding (space) of an element (for
example, 4px for a fixed top padding).

padding-bottom Bottom padding (space) of an element (for
example, 4px for a fixed bottom padding).

text-align Horizontal alignment of text in an element
(for example, center).

font-weight Thinness or thickness of characters in text
(for example, bold).

background Different background properties in one
declaration.

background-color Background color of an element (for
example, green).

color Color of text for an element (for example,
white).

Note: Colors and font styles used in the sample report procedure are intended to highlight the
element that is styled and to illustrate correct syntax. They are not intended to illustrate design
skill.
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The interactive report procedure is as follows:

TABLE FILE CAR 
"Release - &FOCREL "
SUM RCOST DCOST
BY COUNTRY
BY CAR
ON TABLE PCHOLD FORMAT AHTML
ON TABLE SET ARTABLEENGINE JSCHART
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET SQUEEZE ON
ON TABLE SET HTMLCSS ON
ON TABLE SET HTMLENCODE ON
ON TABLE SET CACHELINES 100
ON TABLE SET LOOKTABLE VBAR
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/
ENWarm.sty,$

*TABLE_JS

"styles": {
 "html": 
{".arFilterButton":["font-family:verdana;", "padding-top:4px;", "padding-
bottom:4px;", "text-align:center;", "font-weight: bold;", "background: 
green;", "background-color:green;", "color:white;"]   
}

}
*END
ENDSTYLE
END

At run time, the preceding code generates the following output. The TABLE_JS code is applied
to the elements that are not styled in the WebFOCUS StyleSheet. For example, a green
background with white text is applied to buttons on the Filter Selection dialog box, as shown in
the following image.
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Implementing Cascading Multi Drill

The cascading multi-drill feature enables you to:

Create multiple drill-down links on a data field in an interactive report. For example, you can
create a link to a JavaScript function, a URL, or a detailed report with data that
supplements the first report and extends your scope of analysis.

Arrange the drill-down options for a link in cascading fashion on the interactive report at run
time.

Apply global styling to all the cascading multi-drill menus within the current interactive
report, or item-level styling to a single entry on a menu.

The cascading multi-drill feature supports multiple menu items, as well as multiple cascading
levels. It is implemented in the WebFOCUS language. It includes WebFOCUS StyleSheet code
for the customized display of menus and menu items. Cascading multi drill can be
incorporated in any interactive report that works with JavaScript (for example, HTML or
DHTML).

Note: Currently, you cannot implement cascading multi drill in the GUI.
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You will see a hyperlink on an interactive report when a data value on the report has drill down
or multi drill. By default, the hyperlink is displayed in blue and is underlined. The following
image shows an interactive report with cascading multi drill. A cascading menu is accessed at
the cell level of an interactive report. In this example, the end user left-clicked the linked data
field named Coffee.
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As shown in the next image, you can apply custom styling to the drill-down menus and menu
items on the interactive report, using WebFOCUS StyleSheet code.

For details on the syntax for linking to other resources and for styling cascading multi-drill
menus, see the Multi-Drill Feature With Cascading Menus and User-Defined Styling topic in the
Linking a Report to Other Resources chapter in the Creating Reports With WebFOCUS Language
manual.

Customizing the Page Range on the Pagination Bar

The default string and parameters used to display the page range on the pagination bar of an
interactive report are stored on the WebFOCUS Reporting Server in a file supplied with your
software. Instead of using the default values stored on the server, you can specify your own
customization values within an individual interactive report procedure, using the TABLE_JS
syntax described in this topic. The values specified in the TABLE_JS code will overwrite the
default values, and the customized page range on the pagination bar will be displayed in the
interactive report output.
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This feature eliminates the need for the creation and management of multiple customized files
used in many applications. If you have already made page range customizations using the files
available with your software, the customizations specified in the TABLE_JS code will overwrite
them.

Note:

This feature is available for an interactive report with output format AHTML.

This feature is not available in the GUI.

Syntax: How to Customize the Page Range on the Pagination Bar

The syntax is

*TABLE_JS
 "strings":
{ "paglinetext":"customized_string" }
*END

where:

customized_string

Are the parameters that you supply to customize the page range on the pagination bar.
Valid values are described in the following table.

Parameter Description

%inds Displays the current page number and allows you to type over it with
the number of a page to go to.

%ind Displays the current page number. Does not allow you to type a go-to
page number.

%frcs Is the number of the first record that is displayed. It is a cumulative
number from the first record on the first page, up to the first record
on the current page.

%lrcs Is the number of the last record that is displayed. It is a cumulative
number from the first record on the first page, up to the last record
on the current page.

%trcs Is the total number of records.
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Parameter Description

%pers Is the percentage of the total records that are displayed when a filter
is applied.

%pgs Is the total number of pages.

%rcs Is the total number of records when a filter is applied.

%tn Is a table number used only for internal purposes.

Example: Customizing the Page Range on the Pagination Bar

The following interactive report procedure uses TABLE_JS code to overwrite the default page
range on the pagination bar.

In this example, the number of records displayed on each report page is set in the report
procedure by the WebFOCUS StyleSheet attribute LINES-PER-PAGE. You can also set the
number of records (lines) per page in the GUI for InfoAssist and App Studio. For more
information on the GUI procedure, see the manual for the graphical tool that you are using.

The LINES-PER-PAGE and TABLE_JS code are shown in bold in the example.

Note: If you want to run the example in this procedure, you must combine the two lines of code
between the braces in the TABLE_JS block, so that they are a single line of code, as required
by the syntax rules.
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TABLE FILE CAR
PRINT
     CAR.BODY.DEALER_COST
     CAR.BODY.RETAIL_COST
     CAR.BODY.SALES
BY  LOWEST CAR.ORIGIN.COUNTRY
BY  LOWEST CAR.COMP.CAR
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT AHTML
ON TABLE SET HTMLCSS ON
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/ibi_themes/Warm.sty,$
$
TYPE=REPORT,
     LINES-PER-PAGE=10,
     ARGRAPHENGINE=JSCHART,
     ALLOW-TOOLS=OFF,
$

*TABLE_JS
 "strings":
{ "paglinetext":"%frcs - %lrcs out of %trcs records, Page %inds of 
%pgs<span id='smsg%tn'></span>" } 
*END

ENDSTYLE
END

At run time, the preceding code generates the following pagination bar on the interactive
report. The underscore in Page 1 indicates that you can type a go-to page number here.

To remove the capability to type a go-to page number, use the %ind parameter instead of the
%inds parameter in the TABLE_JS block, as shown here.

*TABLE_JS
 "strings":
{ "paglinetext":"%frcs - %lrcs out of %trcs records, Page %ind of %pgs<span 
id='smsg%tn'></span>" } 
*END

The interactive report will display the following pagination bar, with no underscore in Page 1.
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Controlling the File Compression of Interactive Reports

When creating interactive reports enabled with In-Document Analytics capabilities, you can use
the ARCOMPRESS setting to modify file compression and generate output more quickly. You
can only modify the file compression of interactive reports that use the Designer style of In-
Document Analytics, identified by the setting, ARVERSION=2.

Syntax: How to Control File Compression to Improve Performance

To control the file compression of interactive reports that use In-Document Analytics, use

SET ARCOMPRESS = {ON|OFF}

where:

ON

Enables file compression, and reduces the file size of your output.

OFF

Disables file compression, and improves performance, when you run large data sets.
Caching must also be set to OFF.

Note: Changing this setting may increase or decrease the size of your output file.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT
IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software
Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, FOCUS, iWay, Omni-Gen, Omni-HealthData, and
WebFOCUS are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation and/or its affiliates.

All other product and company names and marks mentioned in this document are the property
of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the
readme file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S)
DESCRIBED IN THIS DOCUMENT AT ANY TIME.
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THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2021. TIBCO Software Inc. All Rights Reserved.
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